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In This Chapter Topics in this chapter include the following:
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About the Primer Express Software

Definition The Primer Express® software allows you to independently design and 
analyze oligos for a variety of PCR and sequencing applications. 

Oligo Design Provides Customized Application-specific Documents

The Primer Express software addresses all of the primary aspects of 
oligo design by providing a customized application-specific document 
for each of the following PCR types:

� Standard DNA PCR

� RT PCR

� Nested PCR

� Allele Specific PCR

� Multiplex PCR

� DNA PCR with TaqMan® probe

Add New Oligo Designs

The Primer Express software allows you to add new oligo designs to a 
database for maintaining records. The software calculates melting 
temperature (Tm) of oligos using the “nearest neighbor” algorithm.

Documents for
Sequencing

The Primer Express software also provides documents for the following 
sequencing applications:

� Cycle Sequencing

� Sequencing Primer

Batch Processing For speed and convenience, the Primer Express software also provides 
a Batch Processing document that gives you the ability to process 
multiple PCR primer calculations at the same time.

Evaluating
Primers

The Primer Express software includes a Primer Test document that 
allows you to evaluate primers for their Tm, secondary structure, and 
primer-dimer formation.
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Contacting Technical Support

Overview You can contact Applied Biosystems for technical support:

� By e-mail

� By telephone or fax

� Through the Applied Biosystems web site

Note For information on obtaining technical documents such as Applied 
Biosystems user documents, MSDSs, and certificates of analysis, see “To 
Obtain Technical Documents” on page 1-9.

By E-Mail To contact Applied Biosystems Technical Support by e-mail for help in 
the following product areas:

Product/Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems (Real-Time PCR) and PCR pcrlab@appliedbiosystems.com

Protein Sequencing, Peptide and DNA Synthesis corelab@appliedbiosystems.com

� Biochromatography

� Expidite∑ 8900 Nucleic Acid Synthesis Systems

� Mass Genotyping Solution 1∑ (MGSI) Systems

� PNA Custom and Synthesis

� Pioneer Peptide Synthesizers

� Proteonomics Solution 1∑ (PSI) Systems

� ICAT∑ Reagent

� PerSeptive DNA, PNA and Peptide Synthesis systems

� FMAT∑ 8100 HTS System

� Mariner∑ Mass Spectrometers

� Voyager∑ Mass Spectrometers

� CytoFluor® 4000 Fluorescence Plate Reader

tsupport@appliedbiosystems.com

LC/MS (Applied Biosystems/MDS SCIEX) support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com
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By Telephone or
Fax

In North America

To contact Applied Biosystems Technical Support in North America, use 
the telephone or fax numbers in the table below.

Note To schedule a service call for other support needs, or in case of an 
emergency, dial 1.800.831.6844, then press 1.

Product/Product Area Telephone Fax

ABI PRISM® 3700 DNA Analyzer 1.800.831.6844, 
then press 8a

1.650.638.5981

DNA Synthesis 1.800.831.6844, 
press 2, then 
press 1a

1.650.638.5981

Fluorescent DNA Sequencing 1.800.831.6844, 
press 2, then 
press 2a

1.650.638.5981

Fluorescent Fragment Analysis 
(including GeneScan® 
applications)

1.800.831.6844, 
press 2, then 
press 3a

1.650.638.5981

Integrated Thermal Cyclers 
(ABI PRISM® 877 and Catalyst 
800 instruments)

1.800.831.6844, 
press 2, then 
press 4a

1.650.638.5981

ABI PRISM® 3100 Genetic 
Analyzer

1.800.831.6844, 
press 2, then 
press 6a

1.650.638.5981

Peptide Synthesis 
(433 and 43x Systems)

1.800.831.6844, 
press 3, then 
press 1a

1.650.638.5981

Protein Sequencing 
(Procise® Protein Sequencing 
Systems)

1.800.831.6844, 
press 3, then 
press 2a

1.650.638.5981
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Sequence Detection Systems 
(Real-Time PCR) and PCR

1.800.762.4001, 
then press:

1 for PCRa

2 for TaqMan® 
applications and 
Sequence 
Detection 
Systems including 
ABI Prism‚ 7700, 
7900, and 5700a

6 for the 6700 
Automated 
Sample Prep 
Systema

or

1.800.831.6844, 
then press 5a

1.240.453.4613

Voyager∑ MALDI-TOF 
Biospectrometry Workstations

Mariner∑ ESI-TOF Mass 
Spectrometry Workstations

MassGenotyping Solution 1∑!
(MGS1) System

Proteomics Solution 1∑ )PS1∗!
System ICAT∑!reagent

1.800.899.5858, 
press 1, then 
press 3b

1.508.383.7855

Biochromatography 
(BioCAD®, SPRINT∑, VISION∑, 
and INTEGRAL®  Workstations 
and POROS® Perfusion 
Chromatography Products)

1.800.899.5858, 
press 1, then 
press 4b

1.508.383.7855

Expedite∑ 8900 Nucleic Acid 
Synthesis Systems

1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

Pioneer Peptide Synthesizers 1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

PNA Custom and Synthesis 1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

Product/Product Area Telephone Fax
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a. 5:30 AM to 5:00 PM Pacific time.

b. 8:00 AM to 6:00 PM Eastern time.

c. 9:00 AM to 5:00 PM Eastern time.

By Telephone or
Fax

Outside North America

To contact Applied Biosystems Technical Support or Field Service 
outside North America, use the telephone or fax numbers below.

FMAT∑ 8100 HTS System

CytoFluor® 4000 Fluorescence 
Plate Reader

1.800.899.5858, 
press 1, then 
press 6b

1.508.383.7855

Chemiluminescence (Tropix) 1.800.542.2369 
(U.S. only),
or 
1.781.271.0045c

1.781.275.8581

LC/MS 
(Applied Biosystems/MDS 
SCIEX)

1.800.952.4716 1.508.383.7899

Product/Product Area Telephone Fax

Region Telephone Fax

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 or
86 800 8100497

86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

India (New Delhi) 91 11 653 
3743/3744

91 11 653 3138

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 79588268 60 3 79549043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 
11

Belgium 32 (0)2 532 4484 32 (0)2 582 1886

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01
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Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0)6150 101 0 49 (0)6150 101 101

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Portugal (Lisboa) 351.(0)22.605.33.14 351.(0)22.605.33.15

Spain (Tres Cantos) 34.(0)91.806.1210 34.(0)91.806.12.06

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk 
a/d IJssel)

31 (0)180 392400 31 (0)180 392409 
or
31 (0)180 392499

United Kingdom (Warrington, 
Cheshire)

44 (0)1925 825650 44 (0)1925 282502

European Managed Territories (EMT)

Africa, English speaking
(Johannesburg, South Africa)

27 11 478 0411 27 11 478 0349

Africa, French speaking
(Paris, France)

33 1 69 59 85 11 33 1 69 59 85 00

India (New Delhi) 91 11 653 3743

91 11 653 3744

91 11 653 3138

Poland, Lithuania, Latvia, and 
Estonia (Warszawa)

48 22 866 40 10 48 22 866 40 20

For all other EMT countries not 
listed (Central and southeast 
Europe, CIS, Middle East, and 
West Asia)

44 1925 282481 44 1925 282509

Japan

Japan (Hacchobori, Chuo-Ku, 
Tokyo)

81 3 5566 6230 81 3 5566 6507

Latin America

Caribbean countries, Mexico, 
and Central America

52 55 35 3610 52 55 66 2308

Region Telephone Fax
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Through the
Applied

Biosystems Web
Site

At the Applied Biosystems web site, you can search through frequently 
asked questions (FAQs) or a solution database, or you can submit a 
question directly to Technical Support.

Brazil 0 800 704 9004 or 
55 11 5070 9654

55 11 5070 9694/95

Argentina 800 666 0096 55 11 5070 9694/95

Chile 1230 020 9102 55 11 5070 9694/95

Uruguay 0004 055 654 55 11 5070 9694/95

Region Telephone Fax

To search the FAQs:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Frequently Asked Questions.

The Frequently Asked Questions page opens.

3 Click your geographic region for the product area of interest.

4 Follow the instructions under the Frequently Asked Questions 
section (1) to display a list of FAQs for your area of interest.

To search the Solutions Database:

Step Action

1 Perform steps 1 and 2 above.

2 Follow the instructions under the Search the Solution Database 
section (2) to find a solution to your problem.

To submit a question directly to Technical Support:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Frequently Asked Questions.

The Frequently Asked Questions page opens.
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To Obtain
Technical

Documents

You can obtain technical documents, such as Applied Biosystems user 
documents, MSDSs, certificates of analysis, and other related 
documents for free, 24 hours a day. You can obtain documents:

� By telephone

� Through the Applied Biosystems web site

Ordering Documents by Telephone

3 In the Personal Assistance – E-Mail Support section (3), click
Ask Us RIGHT NOW.

4 In the displayed form, enter the requested information and your 
question, then click Ask Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your 
question from an Applied Biosystems technical expert.

To submit a question directly to Technical Support: (continued)

Step Action

To order documents by telephone:

1 From the U.S. or Canada, dial 1.800.487.6809, or from outside the 
U.S. and Canada, dial 1.858.712.0317.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.
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Obtaining Documents Through the Web Site

To Obtain
Customer Training

Information

To view, download, or order documents through the Applied Biosystems 
web site:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Documents on Demand.

3 In the search form, enter and select search criteria, then click Search 
at the bottom of the page.

4 In the results screen, do any of the following:

� Click the pdf icon to view a PDF version of the document.

� Right-click the pdf icon, then select Save Target As to download a 
copy of the PDF file.

� Select the Fax check box, then click Deliver Selected Documents 
Now to have the document faxed to you.

� Select the Email check box, then click Deliver Selected Documents 
Now to have the document (PDF format) e-mailed to you.

Note There is a limit of five documents per fax request, but no limit 
on the number of documents per e-mail request.

To obtain Applied Biosystems training information:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Training.
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Hardware and Software Requirements

Hardware
Requirements

The following are the hardware requirements.

Software
Requirements

Windows NT 4.0. Service Pack 3 or greater is highly recommended.

Item Description

Computer 
model

Any PC computer with a Pentium III 

Monitors � The Primer Express® software makes use of color to 
show template, primer, feature, and annotation 
information. 

A color monitor is highly recommended. 

� A 16-inch or larger monitor is recommended to allow 
easier editing and viewing of the Primer Express 
software features. 

Hard disk drive 80 MB minimum

Printer Any PC-compatible printer. The printed results are in black 
and white.For more information about printing, see 
“Printing Settings” on page 7-6.
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How to Install the Primer Express Software 

Supplied with the
Primer Express

Software

The Primer Express software package contains the following items:

� One CD.

� Primer Express Software User’s Manual (this document).

� Primer Express Software Applications Tutorial.

Installing the
Software

IMPORTANT As is true with most installation scripts, it is important that you 
disable any virus protection software during the installation process. After 
installation is complete, you can re-enable any virus protection software.

IMPORTANT The person logged onto the computer must have system 
administrator privileges.

To install the Primer Express software:

Step Action

1 If you have not yet done so, disable any virus protection software 
on your hard disk.

2 Insert the Primer Express software Install disk. Navigate to the CD 
drive on your computer.

3 You will see several files. Click on the Setup file:

The Primer Express Setup program appears.
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4 Click Next and navigate to add the program to your computer.

5 Select the program folder where you want Primer Express to load.

6 Click Next to install the Primer Express software into the 
designated Program Folder.

The software is automatically installed. 

IMPORTANT If the setup program does not automatically run, 
then double-click the setup.exe icon to launch the installer.

7 Take the following action:

a. Click Finish.

b. Eject the Primer Express software disk.

c. Re-enable your virus protection.

d. Restart your PC computer.

Note You do not need to restart in order to use the Primer 
Express software. Restarting reinstates your virus protection and 
cleans up any temporary files created by the installation procedure.

To install the Primer Express software: (continued)

Step Action
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How to Start the Primer Express Software the First Time

Introduction Each Primer Express® software package contains a card with a unique 
registration code. 

Note Your opening of the software package means that you accept the terms 
of the software licensing agreement in Appendix I, “Software License.”

IMPORTANT You can not use the same registration code on more than one 
computer.

Starting the
Primer Express

Software

To start the Primer Express software for the first time:

Step Action

1 Navigate to the program folder for Applied Biosystem and Primer 
Express and double-click the Primer Express software icon.

2 The first time you use the Primer Express software, the registration 
dialog box appears.

Note If you move or delete the Primer Express software Archive 
file or preferences file, you must enter the registration code again.

3 Enter your name, your organization, and your registration code.

The registration code is located on the Primer Express software 
registration card. 

� Store your portion of the card in a safe location.

4 Click OK.

After the registration code is accepted, the Primer Express software 
prompts you to create an archive file for storing primer design 
information. 

To create the Primer Express software Archive file, see “How to 
Create the Primer Express Software Archive File” on page 3-3.
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How to Create the Primer Express Software Archive File

About the Archive
File

The Primer Express software Archive file allows you to store 
information about your oligo designs. Only the Primer Express software 
can read the Primer Express software Archive file. When you save a 
Primer Express document, all the information contained in the 
document is stored in the Archive file.

The Primer Express software Archive file is created the first time you 
launch the Primer Express software.

Creating the
Archive File

The following procedure describes how to create the Primer Express 
software Archive file.

To create the Primer Express software Archive file:

Step Action

1 Launch the Primer Express software.

2 When launching the Primer Express software for the first time, the 
following dialog box appears.

3 Click New to create a new Primer Express software Archive.

4 Use any name that is convenient (the default is PXArchive) to save 
the Primer Express software Archive file. You can store the file 
anywhere on the hard drive.

Note It is recommended that you store the Archive file in the 
Primer Express folder.
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Creating
Additional Archive

Files

Why Create Additional Archive Files

A single archive file is all the Primer Express software needs to store 
primer data for any number of users on the same computer. You can 
create a different archive file at any time. Archive files are used for 
saving data, and your personal or organization’s preferences for data 
and file management may require you to create several archive files.

How to Create Additional Archive Files

5 Click Save to save the new Primer Express software Archive.

To create the Primer Express software Archive file: (continued)

Step Action

For information about... See...

creating additional Primer 
Express software Archive files

“Creating Additional Archive 
Files.”

the different types of Primer 
Express documents and pages

� Chapter 4, “Primer Express 
Documents.”

� Chapter 5, “Primer Express 
Pages.”

To create an additional Primer Express software Archive file:

Step Action

1 Quit the Primer Express software.

2 Double-click the Primer Express software icon to start the program.

3 Immediately after the splash screen first appears, hold down the 
<Alt> key until the dialog box for creating the archive file displays.

Note You must use a different name for the new archive file if you 
want to keep the old file.

4 Click New to create a new Primer Express software Archive.

5 Name the new Archive file and choose a location to save it.

6 Click Save.
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How to Use the Primer Express Software

About the
Interface

The Primer Express software is easy to use, even for the newcomer. 
The steps you use to design oligos with the Primer Express software 
are, for the most part, the same steps you use when designing oligos 
on paper.

The Primer Express software user interface is divided into seven 
functional pages, each with its own tab at the top, as shown below.

Viewing a Page To view a page, click its associated tab.

Note The Primer Express software displays sense strand DNA sequences 
using the convention left-to-right 5´-to-3´, and anti-sense sequence data using 
the convention right-to-left 5´-to-3´.

Process of Using
the Primer

Express Software

After completing the steps in the following table, Table 3-1 lists the 
process of how to use the Primer Express software.

To complete this step... See...

Entering your registration 
information

“How to Start the Primer Express 
Software the First Time” on 
page 3-2.

Creating the Primer Express 
software Archive file

“How to Create the Primer Express 
Software Archive File” on page 3-3.

Table 3-1 Process of how to use the Primer Express software

Step Action See...

1 Import or enter a sequence. “Importing a Sequence” on 
page 5-11.

2 Click the Params tab to view the 
design parameters and make 
changes, if desired. 

“How to Set Parameters” on 
page 5-24.

3 Select the Find Primers Now 
command from the Options 
menu and wait for the process 
to finish.

“Find Primers Now” on 
page 7-14.
Getting Started 3-5



4 Click the Primers tab to view the 
results of the search for 
primers.

All the primers that satisfy the 
design parameters specified in 
the Params page are displayed.

“How to View the Window” on 
page 5-36.

Table 3-1 Process of how to use the Primer Express 

Step Action See...
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How to Learn More

Primer Express
Software

Applications
Tutorial

Whether you are very experienced or new to oligo design, the Primer 
Express Software Applications Tutorials give you an excellent starting 
point for learning how to use the Primer Express software.

For information describing the essential criteria for designing PCR 
primers, sequencing primers, and hybridization probes, see “Primer 
Design Considerations for PCR Application” on page 4-40.

Primer Express
Software

Document Types

The balance of this manual is devoted to describing the functions and 
features of the Primer Express software. Each oligo design application 
uses its own special Primer Express software file, called a document, 
containing parameters used to calculate primers.

The following tutorials are included See

Designing TaqMan Probes for Quantitation 2-1

TaqMan MGB Assays for Allelic Discrimination 3-1

Quick and Easy Oligo Design 4-1

Fine Tuning the Oligo Design 5-1

Oligo Design for Allele Specific PCR 6-1
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List of Document
Types

If you want to skip the tutorials, the next best way to start is to read the 
information describing the type of Primer Express document for your 
intended application. 

The following table lists the Primer Express document types.

Document Type See page

TaqMan Probe and Primer Design Document 4-9

TaqMan MGB Probe and Primer Design Document 4-27

TaqMan MGB Probe Test Document 4-27

DNA PCR Document 4-39

RT PCR Document 4-43

Nested PCR Document 4-46

Allele Specific PCR Document 4-48

Multiplex PCR Document 4-52

Cycle Sequencing Document 4-57

Sequencing Primer Document 4-60

Batch Processing Document 4-61

Primer Test Document 4-67
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4
Primer Express 
Documents 4

Introduction

In This Chapter This section contains descriptions of each the Primer Express® 
document types. For step-by-step instructions on designing oligos using 
the Primer Express software, refer to the accompanying manual, Primer 
Express Software Applications Tutorials.

Topics in this chapter include the following:

Topic See page

About the Documents 4-3

How to Use the Document Window 4-5

TaqMan Assay Design Guidelines 4-7

About TaqMan Probes 4-8

Amplifying Custom Target Sequences for Quantitation 4-9

Using Conventional TaqMan Probes for Amplifying Target 
Sequences for Allelic Discrimination

4-16

Using TaqMan MGB Probes for Amplifying Target Sequences 
for Allelic Discrimination

4-27

TaqMan Assay Design Guidelines 4-39

Primer Design Considerations for PCR Application 4-40

RT PCR Document 4-43

Nested PCR Document 4-46

Allele Specific PCR Document 4-48

About Allele Specific PCR Applications 4-50

Multiplex PCR Document 4-52

How to Calculate Multiplex Primers 4-54

DNA PCR Document 4-57

Cycle Sequencing Applications 4-58

Sequencing Primer Document 4-60
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Batch Processing Document 4-61

How to Use a Batch Processing Document 4-64

Primer Test Document 4-67

Topics in this chapter include the following: (continued)

Topic See page
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About the Documents

What Are the
Documents

The Primer Express software lets you choose from ten different 
application-specific vehicles, called documents, for designing, 
calculating, and investigating primers and probes.

Each Document
Type

Each document type:

� Supports a specific application. For example, if you want to 
calculate primers for Nested PCR, use the Nested PCR document.

� Has a number of features to support oligo design. Most of the 
documents have many features in common (for example, all 
documents have the same Sequence page, except Allele Specific 
PCR, Batch Processing, and Primer Test).

List of Documents The following is a list of the documents.

Notebook Concept The Primer Express software uses the concept of a notebook that 
contains seven pages, each with its own associated tab.

For this document type See

TaqMan Probe and Primer Design Document 4-9

TaqMan MGB Probe and Primer Design Document 4-27

TaqMan MGB Probe Test Document 4-27

TaqMan Assay Design Guidelines 4-39

RT PCR Document 4-43

Nested PCR Document 4-46

Allele Specific PCR Document 4-48

Multiplex PCR Document 4-52

DNA PCR Document 4-57

Sequencing Primer Document 4-60

Batch Processing Document 4-61

Primer Test Document 4-67
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Document
Limitations

The Primer Express software has no artificial limitations on the number 
of documents you can have open at any one time. 

Using the
Multiplex PCR

Document

Because of the complex calculations involved, it is recommended that 
you use only one Multiplex PCR document at a time. If you need to find 
new primers, close the first Multiplex PCR document and open a new 
one.
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How to Use the Document Window

Document
Window Example

The following is an example of a Primer Express document.

Actions You Can
Take

The following table lists the actions you can take.

21 3

5 4

Call 
Out To... Then...

1 move a document 
window

Click and hold the title bar and drag the 
document to a different location on the 
desktop.

2 view a page Click the associated tab.You can copy pages 
so that you can see more than one page at a 
time. 

Three different pages of a DNA PCR 
document are shown in Figure 4-1 on 
page 4-6.

For more information, see “Copy Page To 
Window” on page 7-17.
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Figure 4-1 Viewing more than one document at a time

3 zoom the window Click the Zoom window icon to view all of the 
contents of the window

4 resize the window Click the Resize box.

5 view instructions on 
what actions you can 
take next

Use the Status bar.

You can disable this bar if desired. 

For more information, see “Show/Hide Status 
Bar” on page 7-16).

Call 
Out To... Then...
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TaqMan Assay Design Guidelines

Choose from These
Topics

Choose from the following topics to learn how to design primers and 
probes for your TaqMan® assays:.

Topic See Page

About TaqMan Probes 4-8

Amplifying Custom Target Sequences for Quantitation 4-9

Using Conventional TaqMan Probes for Amplifying Target 
Sequences for Allelic Discrimination

4-16

Using TaqMan MGB Probes for Amplifying Target Sequences 
for Allelic Discrimination

4-27
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About TaqMan Probes

Two Types of
TaqMan Probes

Available

Applied Biosystems offers two different types of probes for TaqMan 
assays:

� TaqMan probes (conventional)

� TaqMan MGB probes

Probes Used in
Quantitation and

Allelic
Discrimination

The conventional TaqMan probes and the TaqMan MGB probes can 
both be used for:

� Allelic Discrimination Assays

� Quantitation Assays

IMPORTANT Applied Biosystems recommends TaqMan MGB probes for 
allelic discrimination, especially when conventional TaqMan probes exceed 30 
nucleotides.

How the Probes
Work

The 5´ nuclease assay is a probe-based PCR detection chemistry. 

� A TaqMan probe is an oligonucleotide with a reporter fluorescent 
dye attached to the 5´ end, and a quencher fluorescent dye 
attached to the 3´ end.

� A TaqMan MGB probe is an oligonucleotide with a reporter 
fluorescent dye attached to the 5´ end and a non-fluorescent 
quencher attached to the 3´ end. The probe is coupled with a minor 
groove binder, which enhances the Tm.

The fluorescent signal increases when the probe is cleaved by the 
AmpliTaq Gold® DNA polymerase during the PCR reaction, thereby 
separating the reporter dye from the quencher.

Probe Features

 TaqMan Probe 5´ Label 3´ Label Features

TaqMan 6-FAMTM, VICTM, 
or TET

TAMRA None

TaqMan MGB 6-FAM, VIC, or 
TET

Nonfluorescent 
quencher

Minor groove 
binder
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Amplifying Custom Target Sequences for Quantitation

TaqMan Probe
and Primer

Document
Example

The TaqMan® Probe and Primer document is used for designing PCR 
primers and their associated conventional TaqMan probe. The following 
is an example of a TaqMan Probe and Primer document showing 
primers and probe graphics.
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Primer and Probe
Design Guidelines

We recommend the following guidelines for designing primers and 
probes for custom 5´ nuclease assays for quantitation.

Note The default values on the Params page in the Primer Express software 
follow the guidelines stated below.

Target Sequence and Amplicon Size Guidelines

� A target template is a DNA, cDNA, or plasmid nucleotide sequence

� Design primers to amplify short segments of DNA within the target 
sequence. These short segments are called amplicons. The 
shortest amplicons work the best. Consistent results are obtained 
for amplicon size ranges from 50–150 bp.

TaqMan Probe Design Guidelines

� Keep G-C content in the 30–80% range.

� Avoid runs of an identical nucleotide. This is especially true for 
guanine, where runs of four or more Gs should be avoided.

� Do not put Gs on the 5´ end.

� Select the strand that gives the probe more Cs than Gs.

� The Tm of the probe should be 68–70 °C.

Primer Design Guidelines

� Choose primer sequences after you have chosen the probe 
sequence.

� Design primers as close as possible to the probe without 
overlapping the probe.

� Keep G-C content in the 30–80% range.

� Avoid runs of an identical nucleotide. This is especially true for 
guanine, where runs of four or more Gs should be avoided.

� The Tm should be 58–60 °C.

� The five nucleotides at the 3´ end should have no more than two G 
and/or C bases.
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Generating a List
of Candidate
Primers and

Probes

Use the software’s default values shown on the Params tab to generate 
a list of candidate primers and probes.

To generate a list of potential primers and probes:

Step Action

1 Import a DNA sequence for designing probes and primers.

To select a 
probe 
from… Then…

a DNA file a. From the File menu, scroll to New submenu, and 
select TaqMan Probe & Primer Design.

A TaqMan Probe document appears.
b. Click Import DNA File.

c. Locate and select a DNA file in the browser.

d. Click Open.

The software loads the sequence and displays it in 
the Sequence tab.

an existing 
TaqMan 
Probe 
document 
(located in 
the 
Document 
Archive)

a. From the File menu, select Open.

The Document Archive dialog box appears.

b. Double-click the document to load, or select the 
sequence and click Open.

The software loads the sequence and displays it in 
the Sequence tab.

a text 
document 
or GenBank 
sequence

a. Select the sequence from the text document or the 
navigator window.

b. From the Edit menu, select Copy.

c. From the File menu, scroll to the New submenu, 
and select TaqMan Probe & Primer Design.

A TaqMan Probe document appears.
d. From the Edit menu, select Paste.

The software pastes the nucleotide sequence into 
the Sequence tab.
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2 Click the Sequence tab. Select the following checkboxes for primer 
selection. 

� Double Stranded

� Limit 3´ G+C 

The sense and antisense sequences appear on the Sequence tab.

3 a. Click the Params tab.

b. Click the Defaults button.

c. Go back to the Sequence page by clicking the Sequence tab.

IMPORTANT Do not change the default settings, as these values 
follow the TaqMan Probe and Primer design guidelines.

To generate a list of potential primers and probes: (continued)

Step Action

Select these boxes
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4 Choose Find Primers & Probe Now from the Options menu.

The software generates a table of forward primers, reverse primers, 
and probes.

5 To examine the list of candidate primers and probes, click the 
Primers tab at the top of the Sequence Tab dialog box. 

To generate a list of potential primers and probes: (continued)

Step Action
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Selecting Primers
and Probes

To select primers and probe:

Step Action

1 Scroll to the right of the forward primers, to the list of TaqMan 
probes. Choose the probe that has more Cs than Gs. 

Note Primer Express software only selects probes on the sense 
strand. It is acceptable to choose a probe on the antisense strand if 
both of the following conditions are met:

a. The antisense probe has more Cs than Gs

b. The antisense probe does not have a G on the 5´end

2
If the probe you have 
chosen is from... Then...

the sense strand go to the Primers tab and click the 
Order button.

Your results can then be copied and 
pasted directly into a Word or 
text-based document.

the antisense strand proceed to step 3.
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3 Note If your probe is from the antisense strand, you will have to 
edit the Order document. The Order document will pick the probe 
sequence only from the sense strand.

To edit the Order document:

a. Click the Sequence tab.

b. Highlight the entire probe sequence.

The probe sequence is outlined in green.
c. From the Edit menu, choose Copy Complement.

d. Return to the Order document and delete the current probe 
sequence.

e. Paste the complementary sequence in its place.

f. Your results can be copied and pasted directly into a Word or  
text-based document. Alternatively, you can save your results 
by choosing Save from the File menu.

Step Action
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Using Conventional TaqMan Probes for Amplifying Target Sequences 
for Allelic Discrimination

How Allelic
Discrimination

Assays Work

In allelic discrimination assays, the PCR assay includes a specific, 
fluorescent, dye-labeled probe for each allele. The probes contain 
different fluorescent reporter dyes (FAM and VIC) to differentiate the 
amplification of each allele.

During PCR, each probe anneals specifically to complementary 
sequences between the forward and reverse primer sites. AmpliTaq 
Gold DNA polymerase can cleave only probes that hybridize to the 
allele. Cleavage separates the reporter dye from the quencher dye, 
which results in increased fluorescence by the reporter dye. Thus, the 
fluorescence signal(s) generated by PCR amplification indicate(s) the 
alleles that are present in the sample.

Mismatches Between Probe and Allele Sequences

Mismatches between a probe and allele reduce the efficiency of probe 
hybridization. Furthermore, AmpliTaq Gold DNA polymerase is more 
likely to displace the mismatched probe rather than cleave it to release 
reporter dye.

The figure below illustrates results from matches and mismatches 
between allele and probe sequences in allelic discrimination assays 
(Livak et al., 1995; Livak et al., 1999).
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Match

V

Q

Mismatch

Mismatch

Q
V

F
Q
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QuencherQ

F

V

GR1556
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The table below summarizes the possible results of the example allelic 
discrimination assay shown above.

TaqMan Probe
and Primer

Document
Example

The TaqMan Probe and Primer document is used for designing PCR 
primers and their associated fluorogenic probe. The following is an 
example of a TaqMan Probe and Primer document showing primers 
and probe graphics.

A substantial increase in… Indicates…

VIC fluorescence only homozygosity for Allele 1.

FAM fluorescence only homozygosity for Allele 2.

both fluorescent signals heterozygosity.
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Loading the
Sequence

To import a DNA file for generating a list of potential primers and 
probes:

Step Action

1 Launch the Primer Express software.

2 Import a DNA sequence for designing probes and primers.

To select 
a probe 
from… Then…

a DNA file a. From the File menu, scroll to New submenu, and 
select TaqMan Probe & Primer Design.

A TaqMan Probe document appears.
b. Click Import DNA File.

c. Locate and select a DNA file in the browser.

d. Click Open.

The software loads the sequence and displays it 
in the Sequence tab.

an 
existing 
TaqMan 
Probe 
document 
(located 
in the 
Document 
Archive)

a. From the File menu, select Open.

The Document Archive dialog box appears.

b. Double-click the document to load, or select the 
sequence and click Open.

The software loads the sequence and displays it 
in the Sequence tab.

a text 
document 
or 
GenBank 
sequence

a. Select the sequence from the text document or 
the navigator window.

b. From the Edit menu, select Copy.

c. From the File menu, scroll to the New submenu, 
and select TaqMan Probe & Primer Design.

A TaqMan Probe document appears.
d. From the Edit menu, select Paste.

The software pastes the nucleotide sequence 
into the Sequence tab.
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3 Select the following checkboxes for primer selection:

� Double Stranded

� Limit 3´ G+C 

The sense and antisense sequences appear on the Sequence tab.

4 Label the polymorphism within the sequence using the Line tool:

a. From the Tools palette, click the Line tool.

b. Select the polymorphic sequence.

The software automatically underlines the polymorphism.

5 Following steps 1-4, import the sequence for the other allele into a 
separate TaqMan Probe document. 

To import a DNA file for generating a list of potential primers and 
probes:

Step Action

Polymorphism
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TaqMan Probe
Design Guidelines

The location of the polymorphism dictates the placement of the probe. 
Because mismatches near the end of the probes tend not to be as 
disruptive to hybridization, Applied Biosystems generally recommends 
designing probes so that the polymorphic site is near the center of the 
probe.

Guidelines for Designing TaqMan Probes

� Use the VIC and FAM reporter dyes to label the allelic 
discrimination probes.

� Avoid runs of an identical nucleotide. This is especially true for G, 
where runs of four or more Gs should be avoided.

� The Primer Express software estimated Tm for the probes should be 
between 65–67 °C.

� The 5´ end of a probe cannot be a G residue. A G residue adjacent 
to the reporter dye will quench the reporter fluorescence somewhat, 
even after cleavage.

� Select the probe strand that gives more Cs than Gs.

� Position the polymorphic site approximately in the middle third of 
the sequence.

Designing the Allele 1 Probe
To design the probe for Allele 1:

Step Action
1 From the TaqMan Probe document for Allele 1, click the Sequence 

tab.

The Sequence tab comes to the front of the dialog box.
4-20 Primer Express Documents



2 Select a region containing potential probe sequences.

a. Highlight the polymorphism and approximately 10 nucleotides in 
both the 5´ and 3´ directions.

b. From the Edit menu, select Copy.

c. From the File menu, scroll to New, and select Primer Test 
Document.

A Primer Test document appears.

d. Click the Forward Primer text box.

e. From the Edit menu, select Paste.

Primer Express copies the sequence into the Primer Test document 
and calculates the Tm using the nearest-neighbor algorithm.

IMPORTANT Do not change the primer and salt concentration 
default values.

Note The software calculates the Tm of the probe sequence even 
though the document is called a Primer Test document.

3 Test potential probe sequences in the complementary strand.

a. Return to the Sequence tab in the TaqMan  Probe document for 
Allele 1. 

The polymorphic sequence and surrounding nucleotides should 
still be selected.

b. From the Edit menu, select Copy Complement.

c. Return to the Primer Test document, and click the Reverse 
Primer text box.

d. From the Edit menu, select Paste.

Primer Express copies the complementary sequence into the test 
document and calculates the Tm of the oligonucleotide.

Note The software calculates the Tm of the probe sequence even 
though the document is called a Primer Test Document.

To design the probe for Allele 1: (continued)

Step Action

10 nucleotides in both 
the 5´ and 3´ directions

Polymorphism
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4 For easier identification, label the polymorphism within each probe 
sequence.

a. Select the polymorphism within the sequence in the Forward 
Primer text box.

b. Press the key corresponding to the letter of the polymorphic 
base.

Primer Express replaces the uppercase letter of the base with a 
lowercase letter.

c. Repeat steps a and b for the complementary sequence in the 
Reverse Primer text box.

5 Highlight potential probe sequences until you identify a probe that 
meets the guidelines in “TaqMan Probe Design Guidelines” on 
page 4-20.

IMPORTANT Primer Express calculates the Tm for only the 
highlighted nucleotide sequence and excludes residues outside the 
selected region from the calculation.

Note Look at potential probes from the complementary 
sequence.

IMPORTANT Add/remove nucleotides evenly to/from both ends of 
the probe so that the polymorphic site remains within the center.

6 From the Edit menu, select Trim.

The software eliminates all but the selected nucleotide sequence 
from the Probe Test document.

To design the probe for Allele 1: (continued)

Step Action
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Designing the Allele 2 Probe

7 Count the number of nucleotides in the probe sequence.

8 To select the probe sequence in the Sequence tab.

a. Go to the TaqMan Probe document for allele 1.

b. From the Primer Express Tools palette, click the probe tool.

c. Select the edited probe sequence on the Sequence tab.

Primer Express highlights the probe sequence in green.
d. Go to the next step, “Designing the Allele 2 Probe.”

To design the probe for Allele 2:

Step Action
1 In the TaqMan Probe document for Allele 2, click the Sequence tab.

To design the probe for Allele 1: (continued)

Step Action

If the probe is... Then...

> 30 nucleotides design an MGB probe as explained 
in “TaqMan MGB Probe Design 
Guidelines” on page 30.

< 30 nucleotides a. Identify the nucleotide strand 
(sense or antisense) with more 
cytosine than guanine residues. 
This strand is the probe 
sequence of interest.

IMPORTANT The 5´ end of the 
probe must not be a guanine 
residue.

b. Copy and paste the final 
sequence for the Allele 1 probe 
into a text document for 
ordering.

c. Go to the next step.
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2 Select a region containing potential probe sequences.

a. Highlight the polymorphic sequence and approximately 
10 nucleotides in both the 5´ and 3´ directions.

b. Copy the sequence for the Allele 2 probe.

IMPORTANT Both probe sequences in the allelic discrimination 
assay must come from same strand, otherwise the two probes will 
hybridize to each other.

c. Open a new Primer Test document from the File menu, and click 
the empty Primer text box.

d. From the Edit menu, select Paste.

Primer Express copies the appropriate sequence into the test 
document and calculates the Tm of the oligonucleotide.

IMPORTANT Do not change the primer and salt concentration 
default values.

3 For easier identification, label the polymorphism within the Allele 2 
probe sequence.

a. Select the polymorphism within the Allele 2 sequence in the 
Primer text box.

b. Press the key corresponding to the letter of the polymorphic 
base.

Primer Express replaces the uppercase letter of the base with a 
lowercase letter.

4 Highlight potential probe sequences until you identify a probe that 
meets the guidelines outlined in “TaqMan Probe Design 
Guidelines” on page 4-20.

5 With the desired probe sequence highlighted, select Trim from the 
Edit menu.

The software eliminates all but the selected nucleotide sequence 
from the Primer Test document.

To design the probe for Allele 2: (continued)

Step Action

If the Allele 1 probe is 
on the…

Then go to the Edit 
menu and select…

sense strand, Copy.

antisense 
(complementary) 
strand,

Copy Complement.
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Designing Primers After selecting probes for the assay, choose primers based on the 
guidelines below. Amplicons should be 50–150 bp in length. By limiting 
the parameters for amplicon design (such as amplicon size), it is 
possible to run all reactions with a single reaction buffer (such as 
TaqMan® Universal PCR Master Mix (P/N 4304437)) and a single 
thermal cycling protocol. 

Guidelines for Designing Primers

� Avoid runs of an identical nucleotide. This is especially true for 
guanine, where runs of four or more should be avoided.

� The Tm of the primers should be 58–60 °C.

� Keep the G + C content within 30–80%.

� Make sure the last five nucleotides at the 3´ end contain no more 
than two G + C residues.

� Place the forward and reverse primers as close as possible to the 
probe without overlapping it.

Steps for Designing Primers

IMPORTANT Design primers after selecting the probe with the probe tool. The 
probe should appear in green.

6 Copy and paste the final sequence for the Allele 2 probe into a text 
document for ordering.

To design the probe for Allele 2: (continued)

Step Action

To design primers for the allelic discrimination assay:

Step Action
1 Click the Sequence tab from the TaqMan Probe document for 

Allele 1.

The Sequence tab comes to the front of the dialog box.
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Note The reaction conditions, recipe, and results pages should not be used 
when designing a TaqMan probe assay.

2 Ensure that the Limit 3´ G+C checkbox from the Sequence tab is 
checked.

3 Select Find Primers/Probes Now from the Options menu.

4 Select a set of primers from the list that will produce the shortest 
amplicon while satisfying the guidelines above.

5 Copy and paste the final primer sequences into a text document for 
ordering.

6 Select Save from the File menu, and assign a name to the file to 
save the results.

The file will be saved in the Primer Express Document Archive 
folder.

IMPORTANT It is not necessary to design primers for the Allele 2 
probe, as the same primer pair will be used for both Allele 1 and 
Allele 2.

To design primers for the allelic discrimination assay: (continued)

Step Action

Must be checked

If the 
software… Then…

finds 
acceptable 
primers

a. Click the Primers tab.

b. Select a primer sequence from the list 
that satisfies all requirements listed 
above.

cannot find 
acceptable 
primers

design the forward and reverse primers 
manually according to the guidelines listed 
above.
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Using TaqMan MGB Probes for Amplifying Target Sequences for 
Allelic Discrimination

How Allelic
Discrimination

Assays Work

In allelic discrimination assays, the PCR assay includes a specific, 
fluorescent, dye-labeled probe for each allele. The probes contain 
different fluorescent reporter dyes (FAM and VIC) to differentiate the 
amplification of each allele.

During PCR, each probe anneals specifically to complementary 
sequences between the forward and reverse primer sites. AmpliTaq 
Gold DNA polymerase can cleave only probes that hybridize to the 
allele. Cleavage separates the reporter dye from the quencher, which 
results in increased fluorescence by the reporter dye. Thus, the 
fluorescence signal(s) generated by PCR amplification indicate(s) the 
alleles that are present in the sample.

Mismatches Between Probe and Allele Sequences

Mismatches between a probe and allele reduce the efficiency of probe 
hybridization. Furthermore, AmpliTaq Gold DNA polymerase is more 
likely to displace the mismatched probe rather than cleave it to release 
reporter dye.

The figure below illustrates results from matches and mismatches 
between allele and probe sequences in allelic discrimination assays 
(Livak et al., 1995; Livak et al., 1999).

Allele
1

Match

V

Q

Mismatch

Mismatch

Q
V

F
Q

Allele
2

Match

Q

F

Legend

AmpliTaq
Gold DNA
Polymerase

VIC

FAM

QuencherQ

F

V

GR1556
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The table below summarizes the possible results of the example allelic 
discrimination assay shown above.

Features of
TaqMan MGB

Probes

IMPORTANT Applied Biosystems recommends the general use of TaqMan 
MGB probes for allelic discrimination, especially when conventional probes 
exceed 30 nucleotides. 

The new TaqMan MGB probes contain the following features:

� A nonfluorescent quencher at the 3´ end

Because the quencher does not fluoresce, the Sequence Detection 
Systems instruments can now measure the reporter dye 
contributions more precisely.

� A minor groove binder at the 3´ end

The minor groove binder increases the melting temperature (Tm) of 
probes allowing the use of shorter probes. Consequently, the 
TaqMan MGB probes exhibit greater differences in Tm values 
between matched and mismatched probes, which provides more 
accurate allelic discrimination.

A substantial increase in… Indicates…

VIC fluorescence only homozygosity for Allele 1.

FAM fluorescence only homozygosity for Allele 2.

both fluorescent signals heterozygosity.
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TaqMan MGB
Probe and Primer

Document
Example

The following is an example of a TaqMan MGB Probe and Primer 
document showing primers and probe graphics.
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TaqMan MGB
Probe Design

Guidelines

IMPORTANT When designing probes, it is important to consider probes from 
both strands.

Follow the guidelines in the table below for designing TaqMan MGB 
probes:

Priority Guideline

1 Avoid probes with a guanine residue at the 5´ end of the probe. A guanine residue 
adjacent to the reporter dye will quench the reporter fluorescence, even after cleavage.

2 Select probes with a Primer Express software–estimated Tm of 65–67 °C.

3 Make TaqMan MGB probes as short as possible without being shorter than 
13 nucleotides.

4 Avoid runs of an identical nucleotide. This is especially true for guanine, where runs of 
four or more should be avoided.

5 Position the polymorphic site in the central third of the probe. 

Note The polymorphic site can be shifted toward the 3´ end to meet the above 
guidelines, however, the site must be located more than two nucleotides upstream from 
the 3´ terminus.

The following figure illustrates the placement of a polymorphism in an example probe 
(N = Nucleotide).

5´ 3´

N N N N N N N N N N N N N N N N N N N N N

Polymorphism

First, try to position the polymorphic 
site in the central third of the probe.

If necessary, place the 
polymorphism here.

Do not place the 
polymorphism 
here.
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Loading the
Sequence

IMPORTANT Because of the asymmetric placement of the minor groove 
binder at the 3´ end, complementary TaqMan MGB probes do not necessarily 
have the same Tm. 

To load the sequence:

Step Action

1 Launch the Primer Express software.

2 Import a DNA sequence for designing probes and primers.

To select a 
probe from… Then…

a DNA file a. From the File menu, scroll to New, and select 
TaqMan MGB Probe & Primer Design.

A TaqMan MGB Probe document appears.
b. Click Import DNA File.

c. Locate and select a DNA file in the browser.

d. Click Open.

The software loads the sequence and 
displays it in the Sequence tab.

an existing 
primer/probe 
document 
(located in the 
Document 
Archive)

a. From the File menu, select Open.

The Document Archive dialog box appears.

b. Double-click the document to load, or select 
the sequence and click Open.

The software loads the sequence and 
displays it in the Sequence tab.

a text 
document or 
GenBank 
sequence

a. Select the sequence from the text document 
or the navigator window.

b. From the Edit menu, select Copy.

c. From the File menu, scroll to the New 
submenu, and select 
TaqMan MGB Probe & Primer Design.

A TaqMan MGB Probe document appears.
d. From the Edit menu, select Paste.

The software pastes the nucleotide 
sequence into the Sequence tab.
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Designing the Allele 1 Probe

3 Select the following checkboxes for primer selection:

� Double Stranded

� Limit 3´ G+C 

The sense and antisense sequences appear on the Sequence 
tab.

4 Label the polymorphism within the sequence using the Line tool:

a. From the Tools palette, click the Line tool.

b. Select the polymorphic sequence.

The software automatically underlines the polymorphism.

5 Following steps 1-4, import the sequence for the other allele into 
a separate TaqMan MGB Probe document. 

To design the probe for Allele 1:

Step Action
1 From the TaqMan MGB Probe document for Allele 1, click the 

Sequence tab.

The Sequence tab comes to the front of the dialog box.

To load the sequence: (continued)

Step Action

Polymorphism
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2 Select a region containing potential probe sequences.

a. Highlight the polymorphism and approximately 10 nucleotides in 
both the 5´ and 3´ directions.

b. From the Edit menu, select Copy.

c. From the File menu, scroll to New, and select 
TaqMan MGB Probe Test Document.

A TaqMan MGB Probe Test document appears.

d. Click the Probe 1 text box.

e. From the Edit menu, select Paste.

Primer Express copies the sequence into the TaqMan MGB 
Probe Test document and calculates the Tm using a specialized 
algorithm for TaqMan MGB probes.

3 Test potential probe sequences in the complementary strand.

a. Return to the Sequence tab in the TaqMan MGB Probe document 
for Allele 1. 

The polymorphic sequence and surrounding nucleotides should 
still be selected.

b. From the Edit menu, select Copy Complement.

c. Return to the TaqMan MGB Probe Test document, and click the 
Probe 2 text box.

d. From the Edit menu, select Paste.

Primer Express copies the complementary sequence into the test 
document and calculates the Tm of the oligonucleotide.

To design the probe for Allele 1: (continued)

Step Action

10 nucleotides in both 
the 5´ and 3´ directions

Polymorphism
Primer Express Documents 4-33



4 For easier identification, label the polymorphism within each probe 
sequence.

a. Select the polymorphism within the sequence in the Probe 1 text 
box.

b. Press the key corresponding to the letter of the polymorphic 
base.

Primer Express replaces the uppercase letter of the base with a 
lowercase letter.

c. Repeat steps a and b for the sequence in the Probe 2 text box.

5 Highlight potential probe sequences until you identify a probe that 
meets the guidelines in “TaqMan MGB Probe Design Guidelines” on 
page 4-30.

Note Look at potential probes from the complementary 
sequence.

IMPORTANT Primer Express calculates the Tm for only the 
highlighted nucleotide sequence and excludes residues outside the 
selected region from the calculation.

6 From the Edit menu, select Trim.

The software eliminates all but the selected nucleotide sequence 
from the TaqMan MGB Probe Test document.

7 Copy and paste the final sequence for the Allele 1 probe into a text 
document for ordering.

8 Double-click the unused Allele 1 probe sequence and press the 
delete key.

The software clears the unused probe sequence from the 
TaqMan MGB Probe Test document.

To design the probe for Allele 1: (continued)

Step Action

Tm reflects this 
region only

Excluded from 
the calculation
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Designing the Allele 2 Probe

9 Label the selected Allele 1 probe.

a. From the TaqMan MGB Probe document for Allele 1, click the 
Sequence tab.

b. Click the Probe tool.

c. Highlight the final probe sequence.

The software labels the probe in green lowercase letters.

To design the probe for Allele 2:

Step Action
1 In the TaqMan MGB Probe document for Allele 2, click the Sequence 

tab.

The Sequence tab appears.

To design the probe for Allele 1: (continued)

Step Action

Probe 
Sequence
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2 Select a region containing potential probe sequences.

a. Highlight the polymorphic sequence and approximately 
10 nucleotides in both the 5´ and 3´ directions.

b. Copy the sequence for the Allele 2 probe.

IMPORTANT Both probe sequences in the allelic discrimination 
assay must come from same strand, otherwise the two probes will 
hybridize to each other.

c. Return to the TaqMan MGB Probe Test document, which contains 
the Allele 1 probe sequence. Click the empty Probe text box.

d. From the Edit menu, select Paste.

Primer Express copies the appropriate sequence into the test 
document and calculates the Tm of the oligonucleotide.

To design the probe for Allele 2: (continued)

Step Action

If the Allele 1 probe is 
on the…

Then go to the Edit menu 
and select…

sense strand, Copy.

antisense 
(complementary) strand,

Copy Complement.

Allele 1 
Probe (for 
reference 
only)

Paste here
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Primer Design
Guidelines

After selecting probes for the assay, choose primers based on the 
guidelines below. Amplicons should be 50–150 bp in length. By limiting 
the parameters for amplicon design (such as amplicon size), it is 
possible to run all reactions with a single reaction buffer (such as the 
TaqMan Universal PCR Master Mix (P/N 4304437)) and a single 
thermal cycling protocol. 

Guidelines for Designing Primers

� Avoid runs of an identical nucleotide. This is especially true for 
guanine, where runs of four or more should be avoided.

� The Tm of the primers should be 58–60 °C.

� Keep the G + C content within 30–80%.

� Make sure the last five nucleotides at the 3´ end contain no more 
than two G + C residues.

� Place the forward and reverse primers as close as possible to the 
probe without overlapping it.

Note The default values on the Params page follow the above guidelines.

3 For easier identification, label the polymorphism within the Allele 2 
probe sequence.

a. Select the polymorphism within the Allele 2 sequence.

b. Press the key corresponding to the letter of the polymorphic 
base.

Primer Express replaces the uppercase letter of the base with a 
lowercase letter.

4 Highlight potential probe sequences until you identify a probe that 
meets the guidelines outlined in “TaqMan MGB Probe Design 
Guidelines” on page 4-30.

5 With the desired probe sequence highlighted, select Trim from the 
Edit menu.

The software eliminates all but the selected nucleotide sequence 
from the probe test document.

6 Copy and paste the final sequence for the Allele 2 probe into a text 
document for ordering.

To design the probe for Allele 2: (continued)

Step Action
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Steps for Designing Primers
IMPORTANT Design primers after selecting the probe with the probe tool. The 
probe should appear in green.

Note The reaction conditions, recipe, and results pages should not be used 
when designing a TaqMan MGB probe assay.

To design primers for the allelic discrimination assay:

Step Action
1 Click the Sequence tab from the TaqMan MGB Probe document for 

Allele 1.

The Sequence tab comes to the front of the dialog box.

2 Ensure that the Limit G+C checkbox from the Sequence tab is 
checked.

3 Select Find Primers/Probes Now from the Options menu.

4 Select a set of primers from the list that will produce the shortest 
amplicon while satisfying the guidelines above.

5 Copy and paste the final primer sequences into a text document for 
ordering.

6 Select Save from the File menu, and assign a name to the file to 
save the results.

The file will be saved in the Primer Express Document Archive 
folder.

IMPORTANT It is not necessary to design primers for the Allele 2 
probe, as the same primer pair will be used for both Allele 1 and 
Allele 2.

If the software… Then…

finds acceptable primers a. Click the Primers tab.

b. Select a primer sequence from the 
list that satisfies all requirements 
listed above.

cannot find acceptable 
primers

design the forward and reverse 
primers manually according to the 
guidelines listed above.
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DNA PCR Document

When to Use the
Document

Use the DNA PCR document when designing primers for PCR using a 
DNA template.

DNA PCR
Document

Example

The following is an example of a DNA PCR document show the 
Sequence page.

Starting the
Document

To start a new DNA PCR document, choose New from the file menu 
and select DNA PCR Document from the submenu.

For more information about the pages contained in the DNA PCR 
document, see Chapter 5, “Primer Express Pages.”
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Primer Design Considerations for PCR Application

Design Criteria Primer design for standard PCR applications depends on a number of 
criteria. 

The basic, and most crucial, requirements are:

� Two primers must be present and complementary to the opposite 
strands of the target DNA template

� Primers must flank the region of interest

� 3´-OH ends of the primers must be oriented towards each other

� Primers should not have significant self-complementarity, that is, 
primers must not anneal to themselves

� 3´-end complementarity between primers must be avoided because 
it leads to primer-dimer artifacts 

� 3´-end complementarity between primers and nonspecific 
sequences present in the template must be avoided

Additional considerations for primer design are the following:

� Keep the Tm of both primers close to each other so that an optimal 
annealing temperature can be easily achieved

� PCR primers should have a moderate GC content (40–60%)

Hairpin Loops If a DNA strand possesses a self-complementary sequence, it may form 
a secondary structure, often called a hairpin loop. Regions that tend to 
form secondary structure should be avoided when designing PCR 
primers. If the potential for secondary structure is great, primers must 
compete against the complementary strand for binding to the target 
sequence, reducing PCR efficiency. 

For more information on how the Primer Express software displays 
nonspecific product formation, see “Show/Hide Primer Secondary 
Structure” on page 7-16.
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Primer-Dimer Primers that anneal to nonspecific locations on the template may give 
rise to nonspecific amplified products. Primers that possess 3´ 
complementarity with themselves or another primer in the PCR reaction 
may form another type of nonspecific product, often called 
primer-dimer. Avoid nonspecific product formation because it 
decreases the quantity of specific product produced and may add 
ambiguity to the PCR results. The Primer Express software calculates 
and eliminates from consideration most of the primer pairs that are 
self-complementary or possess strong primer-dimer tendencies.

Increasing Primer
Specificity

To produce the intended PCR product, the primers used for PCR must 
be very specific, that is, they must form stable primer/template duplexes 
only at the proper locations in the target region. Primer specificity is 
generally increased by increasing either primer length or annealing 
temperature of the primer, or both. Primer length and Tm parameters 
are both set by the user on the Params page. 

For more information on:

� Parameters, see “Standard Parameters Page” on page 5-19.

� DNA PCR, refer to Dieffenbach et al. (1993), Mullis et al. (1987), 
Rychlik (1995), and Rychlik et al. (1990).
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Base-Stacking
Interactions

What Are Base-Stacking Interactions

The Primer Express software uses the nearest neighbor analysis 
method to estimate the melting temperature (Tm) of PCR primers. The 
helical structure of DNA causes adjacent bases to overlap one another. 
The forces between these bases are called base-stacking interactions. 
The strength of such interactions depends upon the sequence of the 
base and its nearest neighbor.

Why Base-Stacking Interaction is Important

In short pieces of DNA (less than 40 bases), the sequence-dependent 
nature of the base-stacking interactions plays a significant role in 
estimating Tm. Various PCR buffers having different salt concentrations 
also play a significant role in estimating Tm.

The desired Tm of PCR primers is strongly dependent upon the PCR 
application and template sequence factors that narrow the choice of the 
primer binding sites. Most PCR primer Tms fall within the 37–68 °C 
range, with higher Tms favoring increased specificity.

Components that Affect the Tm of Primers

In any PCR reaction, the three most important components that affect 
the Tm of the primers are: 

� Concentration of the primers

� Salt (KCl) concentration 

� %GC. 

Increasing one or more of these components increases the primer Tm.
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RT PCR Document

When to Use the
Document

Use the RT PCR document for two-primer PCR starting from the RNA 
template, also referred to as the RNA PCR.

RT PCR
Document

Example

The following is an example of a RT PCR document showing the 
Sequence page for DNA file 0x208.131.

How the Document
Works

When you import a DNA sequence into an RT PCR document, the 
Primer Express software converts it to an RNA sequence, removes 
intron sequences, and marks the intron locations with Junction 
annotations.
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Starting the
Document

To start a new RT PCR document, choose New from the File menu and 
select RT PCR Document from the submenu.

For more information about the pages contained in the RT PCR 
document, see Chapter 5, “Primer Express Pages.”

How GenBank File
Are Imported

When you import a GenBank file into an RT PCR document, the Primer 
Express software modifies the sequence data as follows.

For a diagram illustrating the DNA sequence before and after importing, 
see “Importing Diagram.”

Step Action

1 All T bases are converted into U bases.

This occurs with all DNA sequence files.

2 All the sequence data that makes up the introns is removed and the 
corresponding locations are marked with Junction ( ) 
annotations. 

This occurs with GenBank files only.

3 The resulting sequence displayed in the Sequence page is shorter 
than the original sequence because the intron data is spliced out.

For example, the imported sequence DROGNBPSA3.gb (shown in 
“RT PCR Document Example” on page 4-43) was originally 
1380 bp long. Splicing out the introns results in a sequence length 
of 804 bp.

The Primer Express software calculates only those primer pairs in 
which at least one primer spans at least one intron/exon junction.
4-44 Primer Express Documents



Importing
Diagram

The following diagram shows the DNA sequence before and after being 
imported into an RT PCR document.

GenBank file sequence data 
before being imported 
[sequence length: 32 bp]

exon exonintron

GenBank file sequence data after being 
imported (exons spliced together and T’s 
replaced with U’s) [sequence length: 17 bp]

AAAAAACCCCCCCCCCCCCCCTTTTTTTTTTT

AAAAAAUUUUUUUUUU

exon exon

Junction annotation inserted on Sequence page where intron was 
removed (see “RT PCR Document Example” on page 4-43)
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Nested PCR Document

When to Use the
Document

The Nested PCR document generates two pairs of primers, one pair 
nested inside the other. Nested PCR provides a means of increasing 
the specificity of the internal primer pair.

Nested PCR
Document

Example

The following is a nested PCR document showing the Sequence page 
for the DNA file.

P1 P3

P4 P2

Amplicon
Sense 
strand

Anti-sense 
strand
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Starting the
Document

To start a new Nested PCR document, choose New from the File menu 
and select Nested PCR Document from the submenu.

For more information about the pages contained in the Nested PCR 
document, see Chapter 5, “Primer Express Pages.”

Nested PCR
Applications

Nested PCR is a technique used to improve either the sensitivity or the 
specificity of PCR by using two sets of PCR primers instead of one. For 
example, nested PCR is often chosen for single-cell amplification or to 
amplify a single gene from an array of duplicated or pseudo genes. 
Nested PCR is also used to generate PCR templates from genomic 
DNA for subsequent DNA sequencing.

An inner and outer set of primers are used in nested PCR. Typically, the 
outer primers are used for the initial cycles of amplification of the target 
DNA. The inner primers are used for subsequent cycles of amplification 
to produce a highly specific PCR product.

Because of the complexity of the nonspecific complementarity of 
primer–primer and primer–template sequences, the Primer Express 
software makes it a lot easier to design primers for Nested PCR.

For more information on Nested PCR, refer to Plikaytis et al. (1990).
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Allele Specific PCR Document

When to Use the
Document

The Allele Specific PCR document is designed for calculating primers 
that amplify a sequence within one or more alleles and that specifically 
do not amplify a sequence within one or more different alleles. You can 
also design a universal primer that amplifies all the alleles.

Allele Specific
PCR Document

Example

The following is an example of an Allele Specific PCR document 
showing the Sequence page. 

How to Use the
Document

The Allele Specific document imports only sequence alignments. 

The Sequence page (see “DNA PCR Document Example” on 
page 4-39) is unique to the Allele Specific PCR document. For 
information describing the features of the Allele Specific Sequence 
page, see “Features” on page 5-9.

You can take the following action Result

Select which sequences in the 
alignment you want amplified and 
which not.

Each primer pair found must contain 
at least one discriminatory residue.

The Primer Express software 
determines which residue positions 
discriminate between sequences in 
the amplified set and those in the 
not-amplified set. 
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Starting the
Document

To start a new Allele Specific PCR document, choose New from the File 
menu and select Allele Specific PCR Document from the submenu.
For more information about the pages contained in the Allele Specific 
PCR document, see Chapter 5, “Primer Express Pages.”
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About Allele Specific PCR Applications

What is Allele
Specific PCR

Allele specific PCR is a technique used to identify point mutations that 
occur at known locations in a target DNA (for example, sickle-cell 
anemia). This method allows direct detection of mutations in genomic 
DNA without probe hybridization, ligation, or restriction enzyme 
cleavage.

Process The following describes the how allele specific PCR works. 

Step Action

1 Two primers are designed as in standard DNA PCR, but only one 
primer is specific to the mutant allele. 

The 3´-end nucleotide of the allele specific primer is complementary 
to the mutant nucleotide but not to the wild type.

2 If the target DNA contains the mutation of interest, then the allele 
specific primer binds and amplifies the product normally. 

Only linear amplification from the other primer occurs on the wild 
type template because DNA polymerases, including AmpliTaq® 
DNA polymerase, tend not to extend from a mismatched 
nucleotide. 

This tendency produces a low level of linear amplification product 
that is not detected normally. Therefore, the presence of an 
amplified product in allele specific PCR acts as an indicator for the 
presence of the mutation.
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Select Mismatch
Nucleotide

All general rules for standard PCR primer design apply for allele 
specific PCR. In addition, it is very useful to select a mismatch 
nucleotide for the allele specific primer that has the lowest probability of 
mismatch extension by the polymerase (Figure 4-2).

Figure 4-2 Allele specific primer with mismatched nucleotide

Reducing
Mismatch
Extension

Set the annealing temperatures of the primers to greater than 50 °C to 
help reduce the likelihood of mismatch extension. 

Reducing False
Positives

Use of the Stoffel fragment of Taq DNA polymerase helps to reduce 
false positives in many allele specific PCR assays. If Stoffel is used, 
consider salt concentrations in the Stoffel buffer for estimating primer 
Tm. 

For More
Information

For more information on:

� Enzyme selection, see Appendix D, “PCR Enzymes and Primer 
Express.” 

� Allele specific PCR, refer to Sommer et al. (1992) and Tada et al. 
(1993).

A T G C

T C AA

Wild type 
template

Allele specific 3´ 

3´

5´

Mismatched 
nucleotide yields 
no PCR product
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Multiplex PCR Document

When to Use the
Document

The Multiplex PCR document is used to calculate many sets of primers 
that you can use in the same PCR reaction to amplify many different 
target sequences simultaneously.

Multiplex PCR
Document

Example

The following is an example of a Multiplex PCR document showing the 
Sequence page.

Starting the
Document

To start a new Multiplex PCR document, choose New from the File 
menu and select Multiplex PCR Document from the submenu.

For more information about the pages contained in the Multiplex PCR 
document, see Chapter 5, “Primer Express Pages.”

Imported file 
pop-up 
menu
4-52 Primer Express Documents



Multiplex PCR
Document
Functions

You can import up to 16 sequences into a Multiplex PCR document, 
then independently annotate each sequence. For more information, see 
“Importing a Sequence” on page 5-11.

The following are standards for primer calculations in a Multiplex PCR 
document:

� All primer pairs calculated must pass all tests for primers

� Tm values for all primers must be close to each other

� No primer-dimer reactions are allowed among any of the primers in 
the reaction

� Amplified products of all PCR reactions must differ from each other 
in length by a user-selectable margin sufficient to distinguish them 
all by electrophoresis

Because of the complex and memory-intensive calculations involved, it 
is recommended that you use only one Multiplex PCR document at a 
time. If you need to find new primers, close the first Multiplex PCR 
document and open a new one.

Multiplex PCR
Document Options

The Multiplex PCR document contains three unique options on the 
Params page. For information, see “Features” on page 5-5.

Setting Multiplex
Parameters

The default parameters in the Primer Express software are set at 
values that generate a useful number of primer pairs for most the 
Primer Express document types.

In general, Multiplex PCR documents require parameters with relaxed 
stringency because of the inherent difficulty in finding primer pairs. It is 
advisable to set the parameters to more relaxed values in the 
Preferences dialog box, so that any Multiplex PCR documents you 
open automatically have the correct parameters for you. For more 
information, see “Preferences Command” on page 7-13.
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How to Calculate Multiplex Primers

Introduction You can use the Multiplex PCR document to calculate:

� Multiple sequences, each amplified by a single primer pair

� One large sequence and specify a number of different targets

For information on importing sequence files, see “Importing a Sequence” 
on page 5-11.

Calculating
Multiple

Sequences

To calculate primers for multiple sequence files.

Step Action

1 Import each DNA sequence file into the Multiplex PCR document.

2 Set Parameters on the Params page.

3 Annotate the target region for each imported sequence.

For more information, see “Adding a Target Annotation” on 
page 6-6.

4 From the Options menu, select Find Primers Now to calculate 
primers.
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Calculating
Multiple Targets in

a Sequence

There are two methods for calculating multiple targets in a single 
sequence file. Both methods are equally effective.

Using Method 1

To calculate primers for multiple targets in a single sequence:

Step Action

1 Open a new Multiplex PCR document.

2 On the Params page, significantly relax the stringency of the 
following parameters:

� Primer minimal Tm

� Primer minimal and maximal length

� Primer GC content

� Amplicon minimal Tm

� Amplicon minimal and maximal length

3 On the Sequence page, import a DNA sequence. 

4 From the Options menu, select Find Primers Now.

The Primer Express software calculates primers for this sequence. 

5 On the Sequence page, use the Line tool to underline the target 
regions you are interested in amplifying.

6 On the Map page, do the following:

a. Compare the locations of your underline annotations and any 
primer pairs. 

You may need to scroll down or change the magnification to 
make comparisons. Find existing primer pairs that amplify your 
underlined regions.

b. Select a primer pair (click it) that amplifies a region you have 
underlined.

7 On the Sequence page, use the Target tool to select all or part of 
the region that is highlighted and underlined.

8 Repeat step 6b and step 7 until as many underlined regions as 
possible are also annotated as Target regions.

9 From the Options menu, select Find Primers Now.

10 After the Primer Express software calculates primers, note how 
many are found.

11 Change to the Params page. In the pop-up menu named Last four 
positions contain, select the second option. 
Primer Express Documents 4-55



Using Method 2

12 From the Options menu, select Find Primers Now.

13 Repeat step 10 and step 11 until you have tried all four menu 
options and determined which option gives you the most primers.

To calculate primers for multiple targets in a single sequence file.

Step Action

1 Open a new Multiplex PCR document.

2 On the Params page, significantly relax the stringency of the 
following parameters:

� Primer minimal Tm

� Primer minimal and maximal length

� Primer GC content

� Amplicon minimal Tm

3 On the Params page, set the Amplicon minimal and maximal length 
parameters to the desired target region size (50 to 200 bases).

4 On the Sequence page, import a DNA sequence.

For information on importing sequence files, see “Importing a 
Sequence” on page 5-11.

5 Use the Target tool to specify exact minimal target regions, limiting 
the target annotations to 10–20 bases.

6 From the Options menu, select Find Primers Now.

The Primer Express software calculates primers for this sequence. 
This process could take several minutes or more, depending on the 
power of your computer and the values of the new parameters.

7 After the Primer Express software calculates primers, note how 
many are found.

8 Change to the Params page. In the Last four positions contain 
pop-up menu, select the second option.

9 From the Options menu, select Find Primers Now.

10 Repeat step 7 through step 9 until you have tried all four primer end 
composition options and found which option gives you the most 
primers.

To calculate primers for multiple targets in a single sequence: (continued)

Step Action
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Cycle Sequencing Document

When to Use the
Document

The Cycle Sequencing document is designed for finding primers to use 
in DNA sequencing using a thermostable polymerase.

Cycle Sequencing
Document

Example

The following is an example of the Cycle Sequencing Document 
showing the Sequence page.

What to Use The
Document For

The Cycle Sequencing document provides the ability to find forward 
and reverse primers. The Primer Express software uses the same 
criteria to evaluate candidate sequencing primers that it uses to 
evaluate PCR primers. In addition, you can specify Primer Position 
Requirements to make certain that all primers found are a specified 
distance from the end towards which they prime.

Starting the
Document

To start a new Cycle Sequencing document, choose New from the File 
menu and select Cycle Sequencing Document from the submenu.
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Cycle Sequencing Applications

Introduction In vitro DNA synthesis, as in DNA sequencing based on the chain 
termination method developed by Sanger et al. (1977), requires a 
template that is single stranded. An easy and efficient method of 
generating single-stranded DNA from double-stranded molecules is to 
heat-denature the samples in solution in order to disrupt the hydrogen 
bonds between the complementary bases of the two strands.

Primer Annealing Primer annealing can occur when the temperature is brought down to a 
level below its Tm. You can then use a DNA polymerase to extend the 
DNA chain from the annealed primer. By using AmpliTaq® DNA 
polymerase, FS, you can perform this process of denaturation, primer 
annealing, and extension over and over again using a limited amount of 
starting template and primer. This process is called cycle sequencing. 
Although it resembles PCR, cycle sequencing involves amplification 
from a single strand of DNA and a single primer and is, therefore, also 
referred to as linear amplification sequencing. PCR amplification, on the 
other hand, is exponential, because two strands of DNA are 
synthesized from two strands of template and two primers.

Requirements for
Cycle Sequencing

Cycle Sequencing Requirements

Cycle sequencing with AmpliTaq DNA polymerase, FS has certain 
unique requirements; consequently:

� Good primer design is crucial for achieving optimal results. 

Primers for cycle sequencing should be 18–24 bases long (22 
bases being optimal) with a GC content of 50–55% and a Tm of 
approximately 55–60 °C.

� Avoid low Tm (40–45 °C) and low GC content.

If the GC content is low, compensate with a longer primer. 

� Avoid strings of four or more identical bases and mismatches within 
the primer sequence. 

Secondary structures in the primer, particularly at the 3' end, can 
lead to formation of hairpin loops. The Cycle Sequencing document 
in the Primer Express software is specifically designed to 
accommodate the above parameters.
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For More Information

For more information on 

� cycle sequencing applications, refer to Applied Biosystems (1995) 
and Sanger et al. (1977).

� the pages contained in the Cycle Sequencing document, see 
Chapter 5, “Primer Express Pages.”
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Sequencing Primer Document

When to Use the
Document

The Sequencing Primer document is used to find primers in Sanger 
dideoxy nucleotide sequencing reactions, which use a nonthermostable 
polymerase.

Sequencing Primer
Document

The following is an example of a Sequencing Primer document showing 
the Sequence page.

How the Document
Works

The Primer Express software uses the same criteria to evaluate 
candidate sequencing primers that it uses to evaluate PCR primers. In 
addition, you can specify Primer Position Requirements to make certain 
that all primers found are a specified distance from the end towards 
which they prime. For more information about setting parameters for the 
Sequencing Primer document, see “Parameters Page for Sequencing” 
on page 5-29.

Starting the
Document

To start a new Sequencing Primer document, choose New from the File 
menu and select Sequencing Primer Document from the submenu.

For more information about the pages contained in the Sequencing 
Primer document, see Chapter 5, “Primer Express Pages.”
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Batch Processing Document

When to Use the
Document

The Batch Processing document is used to process a group of 
sequence files automatically as multiple Primer Express documents. A 
Batch Processing document can process sequences using all Primer 
Express document types, except for Allele Specific PCR and Primer 
Test.

Note Unlike most other Primer Express documents, the Batch Processing 
document does not contain pages or tabs.

Batch Processing
Document

Example

The following is an example of a Batch Processing document.

How Much You
Can Import

You can import up to 48 sequences into a Batch Processing document. 
However, the more sequences being processed, the greater the chance 
that the speed of the program will be degraded. Remember that the 
speed at which the Primer Express software finds primers is limited by 
the power of your PC computer.
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Starting a
Document

To start a new Batch Processing document, choose New from the File 
menu and select Batch Processing Document from the submenu.

Features The Batch Processing document has the following features.

Item Description

Add Button

The Primer Express 
software Drag-and-Drop 
feature allows you to drag 
individual sequence files or 
an entire folder of 
sequence files onto a Batch 
Processing document. For 
more information, see 
“Importing a Sequence” on 
page 5-11.

Displays a dialog box that allows you to select 
sequence files to add to the Batch Processing 
document. You can add files one at a time or 
in a group

Delete Button Removes the highlighted sequence file from 
the Batch Processing document. This button 
is inactive until at least one sequence file has 
been added.

Prefs Button Displays the Preferences dialog box. 

For more information, see “Preferences 
Command” on page 7-13.

Go Button Causes the Primer Express software to 
calculate primers for every sequence file 
contained in the Batch Processing document. 

While primers are being calculated, the button 
becomes the Stop button. 

Click the Stop button to interrupt the primers 
being calculated. The Go button becomes 
inactive after primers have been calculated 
for all the sequences in the Batch Processing 
document.
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Summary Button Displays a window (Figure 4-3) that contains 
the number of primers calculated and the 
primer data for each sequence in the Batch. 
Processing document. 

This button is active only after primers have 
been calculated.

You can copy the text in the Summary window 
and paste it using standard PC commands.

Figure 4-3 Batch Processing summary window

Order Button Displays an electronic form for ordering 
primers electronically. 

For more information, see “How to Order 
Primers” on page 5-37.

Item Description
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How to Use a Batch Processing Document

Introduction The Batch Processing document is designed to take much less time 
than you would spend finding primers for many individual documents. 
The following procedure contains the steps you must follow to use the 
Batch Processing document.

Note You cannot save Batch Processing documents, but the individual 
documents within a Batch are automatically saved to the Primer Express 
software Archive file immediately after processing.

Using a Batch
Processing
Document

The following procedure describes how to use a Batch Process 
document.

To use a Batch Processing document:

Step Action

1 Open a Batch Processing document.

2 Click the Prefs button to display the Primer Express software 
parameter preferences. Set the Preferences for each document 
type.

Note Changing the parameter preferences does not change the 
parameters in documents already imported into a Batch Processing 
document. For more information, see “Preferences Command” on 
page 7-13.

3 Import one or more sequences into the Batch Processing 
document. 

For more information, see “Importing a Sequence” on page 5-11.

4 Assign each document a Doc Type:

a. For the entire batch of documents (from the heading pop-up 
menu) or

b. Individually (from the pop-up menu for each individual 
document)

For more information, see “Changing Document Type for an 
Individual Sequence” on page 4-65.

5 Click the Go button to process the Batch Processing document.

6 If any sequences generated zero primers, double-click the 
individual document name to open it.

7 Change parameters on the Params page. 

For more information, see “How to Set Parameters” on page 5-24.
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Changing
Document Type

for an Individual
Sequence

When you add a sequence file to the Batch Processing document, it is 
assigned a DNA PCR document type by default. You can change the 
document type for each sequence file individually or for all the 
sequence files in the Batch Processing document.

8 Make the Batch Processing document the active document by

� Clicking it to bring it to the foreground, or

� Selecting the Batch Processing document name from the 
Windows menu

9 Click the Go button to process the Batch Processing document.

Note The Primer Express software calculates primers only after 
you click the Go button in the active Batch document.

10 If any sequences generate zero primers, go back to step 6 of this 
procedure.

To use a Batch Processing document: (continued)

Step Action

To change the document type for each individual sequence:

Step Action

1 Click the desired sequence file to select (highlight) it.

2 Click the Doc Type of the selected sequence file to display a pop-up 
menu.

3 Select the document type from the pop-up menu. 

The individual sequence file displays the selected document type.
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Changing
Document Type

for All Sequence
Files

Viewing the
Associated Primer
Express Document

After choosing the document type for each sequence in the Batch 
Processing document, you can view each sequence file in its own 
Primer Express document.

To do this, double-click the sequence name to open a corresponding 
Primer Express document of the type selected.

IMPORTANT Do not double-click the sequence name until after you have 
selected the correct document type. Opening the corresponding Primer Express 
document locks the document type.

To change the document type for all sequence files in the document.

Step Action

1 Click the heading named Doc Type to display a pop-up menu.

2 Select the document type from the pop-up menu. 

All sequence files in the Batch Processing document display the 
selected document type.

Click here to display pop-up menu
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Primer Test Document

When to Use the
Document

The Primer Test document allows you to enter two primer sequences 
and immediately observe their Tm and %GC, as well as any potential 
secondary structure and primer-dimer formation. You can enter primer 
sequence data either directly from the keyboard or by pasting from 
another document (the Primer Express document, text file, and so on).

Primer Test
Document

Example

The following is an example of a Primer Test Document.

Primer data

Potential secondary
structure

Primer-dimer
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Starting the
Document

To start a new Primer Test document, choose New from the File menu 
and select Primer Test Document from the submenu.

Features The following table lists the features of the Primer Test document.

Feature Description

Primer 
Concentration

Allows you to change the primer concentration value 
(default = 50 nM).

Salt Allows you to change the salt concentration value 
(default = 50 mM).

Forward & Reverse 
Primer

Type or paste into these data fields the sequence 
text of the forward and reverse primers that you wish 
to test. 

Each primer data field can hold sequence text 
containing up to 40 bases.

Secondary 
Structure Graphic

Shows all potential complementarity among bases 
internal to each primer.

Primer Dimer 
Graphic

Shows all potential complementarity between the 
two primers. 

A-T bonds are shown as a thin line and C-G bonds 
are shown as a thick line.
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5
Primer Express Pages5
Introduction

In This Chapter This chapter contains descriptions and procedures for the following:

Topic See page

About the Primer Express Software Pages 5-2

Standard Sequence Page 5-4

Sequence Page: Allele Specific PCR 5-8

Working With Sequences 5-11

How to Find Primers 5-16

Standard Parameters Page 5-19

How to Set Parameters 5-24

Parameters Page: Multiplex PCR 5-25

Parameters Page: Allele Specific PCR 5-27

Parameters Page for the TaqMan Probe 5-28

Parameters Page for Sequencing 5-29

Reaction Conditions Page 5-30

Primers Page 5-33

How to Order Primers 5-37

Map Page 5-38

Map Page for Nested PCR 5-44

Standard Recipe Page 5-45

Recipe Page for Cycle Sequencing 5-45

Recipe Page for Sequencing Primer 5-49

Results Page 5-50

Results Page for Nested PCR 5-52

Other Primer Express Software Views 5-53
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About the Primer Express Software Pages

Pages and Tabs With the exception of Batch Processing and Primer Test and TaqMan® 
MGB Probe Test, each Primer Express® document contains seven 
different pages. Each page has its own tab, as shown below.

See “Page Names and Tab Names” for the name of each page along 
with its corresponding tab name.

Page Names and
Tab Names

The following table lists the name of each page along with its 
corresponding tab name.

Viewing a Page To view any Primer Express page, click the tab associated with that 
page.

Page Name Tab Name Purpose

Sequence Sequence Enter and annotate sequence data

Parameters Params Set specs for primer Tm and length, 
amplicon Tm and length, %GC, base 
repeat, 5´ tail

Reaction 
Conditions

Rxn Cond Set DNA, salt, and Mg concentrations; 
select PCR enzyme

Primers Primers View and sort primer pair results

Map Map View and sort primer pair graphics and 
Tm/%GC graphics

Recipe Recipe Calculate PCR concentrations and print 
protocol

Results Results Record results of PCR reaction using 
calculated primers
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Dynamically
Linking Pages

When you use the Primer Express software, you make a number of 
changes to sequence data and annotations, as well as view and sort 
primer data on several different pages.

Each page of the Primer Express software is dynamically linked to all 
the others, so that when you sort data or calculate primers on one page, 
the results are reflected on every page (see “Dynamic Linking 
Example”).

Dynamic Linking
Example

The following is an example of the Sequence page, Primers page, and 
Map page showing feature connected by means of dynamic linking.

Sequence page

Primers page

Primer Data window

Map page

Forward primer sequence 
data updated 
simultaneously on all 
pages when selected or 
modified
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Standard Sequence Page

About the Page The Standard Sequence page allows you to import or enter one or more 
sequences. The Standard Sequence page is a part of all the Primer 
Express documents except the Allele Specific PCR document, which 
has its own special Sequence page (see “Features” on page 5-9), 
Batch Processing and Primer Test documents, which have no 
Sequence page at all, and TaqMan MGB Probe Document.

All Primer Express documents require a sequence or alignment file of 
some sort to use as the basis for calculating primers. 

Sequence Page
Example

The following is an example of a Sequence page from a DNA PCR 
document, into which the sequence file ox208.131 has been imported.
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DNA Sequence
File Formats

The Primer Express software accepts DNA sequence files in the 
following formats:

Alignment File
Formats

The Primer Express software accepts alignment files for Allele Specific 
PCR in Sequence Navigator®. For more information, see “Importing a 
Sequence” on page 5-11.

You may enter sequence data directly from the keyboard if you desire. 
For more information, see “Entering a Sequence” on page 5-12.

Features The following are features of the Standard Sequence page.

Factura EMBL

GenBank ABIF

ABI 373/377/310 sample files FASTA

GCG Plain text files

1 2 3 4 5 6

8

9

10

11 7
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The following table lists the features of the Standard Sequence page.

Call 
0ut Item Description

1 Sequence 
Data Lock

Shows whether the sequence data is

� Locked ( )

� Unlocked ( )

Click the icon to change the lock status.

For more information, see “Locking and Unlocking a Sequence” on 
page 5-13.

2 Length Shows the number of base pairs contained in the sequence being displayed 
on the Sequence page.

If no sequence file has been imported, this display reads “0 bp.”

3 File Name Shows the name of the sequence currently imported into the document. 

In a Multiplex PCR document, the names of all imported sequences appear in 
a pop-up menu. The name of the sequence currently displayed on the 
Sequence page appears in the pop-up menu. If no sequence file has been 
imported, this display reads “No File Loaded.” You can change the text in the 
File Name data display by highlighting the existing name and typing a new 
name. If you change the sequence name, then use the Export function. For 
more information, see “Printing Settings” on page 7-6.

4 Selection Shows the beginning and ending range of highlighted bases.

5 Import DNA 
File button

Allows you to import a sequence file through the standard PC file navigation 
dialog box.

In a Multiplex PCR document, you can import multiple sequences. 

After you import a file, the button is grayed out (except Multiplex PCR).

For more information on importing sequences, see “Importing a Sequence” 
on page 5-11.

6 Double 
Stranded 
View 
Checkbox

When the checkbox is selected, displays both strands of the sequence data.

7 Limit 3 G+C Used in TaqMan MGB probes—used to limit the guanine + cytosine residues 
in analysis.

8 Sequence 
Data Pane

Contains sequence data entered using the keyboard or imported.
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9 Line Length 
Control

Reformats the sequence data to fill the sequence data pane, up to a 
maximum of 120 base pairs per sequence line. 

Sequence line length is controlled by a slider control (a solid arrowhead) 
located on the right just above the sequence pane. 

The sequential number of the final base pair on each line is shown in the right 
margin of the sequence data pane. 

You can display sequence data in lines from 20–120 bp long.

To change line length:

a. If you are increasing the line length, increase the horizontal size of the 
Primer Express software window.

b. Position the cursor over the slider control.

When in position, the cursor changes to the slider control cursor ( ).
c. Click and drag to change the line length.

To increase line length, drag to the right. To decrease line length, drag to the 
left.

10 Scroll Bar If the Standard Sequence page contains more sequence data than you can 
view at one time, a scroll bar appears on the right side of the page to allow 
you to view all the sequence data.

11 Base 
Grouping 
Control

Groups the sequence data into easily read sections of nucleotides. 

The default grouping is ten bases. The grouping is controlled by a slider 
control (a hollow arrowhead) located on the left just above the sequence data 
pane. 

Directly beneath the slider control is a ruler that indicates the size of the 
grouping. You can group sequence data into sections ranging in size from 
1–120 bp or set for no grouping.

To change the base grouping:

a. Position the cursor over the slider control.

When in position, the cursor changes to the slider control cursor ( ).
b. Click and drag to change the grouping.

To

� Increase group size, drag to the right

� Decrease group size, drag to the left.

� Eliminate grouping, drag all the way to the left.

Call 
0ut Item Description
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Sequence Page: Allele Specific PCR

About the Page The Allele Specific PCR document uses sequence alignments rather 
than individual sequence files. For this reason, the Allele Specific PCR 
Sequence page has a number of features different from the Standard 
Sequence page.

Allele Specific
PCR Sequence
Page Example

The following is an example of the Allele Specific PCR Sequence page 
with imported sequence.

1
2

3 4 5 6 7
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Features The following table describes the call outs in the above figure.

Call 
Out Feature Description

1 Consensus Shows the degeneracy of any base position. Degenerate residues are colored 
white and conform to IUPAC base composition conventions. 

For a full description of IUPAC codes, see Appendix F, “IUPAC Codes.” All 
nondegenerate residues use standard base colors generated by ABI PRISM® 
automated sequencers and genetic analyzers (see table below).

The consensus sequence shows the IUPAC composition of each base 
position, the linear sequence numbering, asterisks that indicate discriminatory 
residues, primer graphics, and any annotations made to the sequence data.

2 Total 
Sequences

Shows the number of sequences in the imported alignment file.

3 File Name Shows the name of the alignment imported into the document. If no sequence 
file has been imported, this display is blank.

4  # Included Shows the number of sequences that are included (checkbox is selected) in 
the current alignment. 

All primers calculated amplify the included sequences and do not amplify the 
excluded sequences.

5 # Excluded Shows the number of sequences that are excluded (checkbox is deselected) 
from the current alignment. 

All primers calculated amplify the included sequences and do not amplify the 
excluded sequences.

6 Import 
Alignment File 
button

Allows you to import an alignment file through a standard PC file navigation 
dialog box.

Code Color

A green

C blue

G yellow

T red
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7 # Discrim Res 
(discriminatory 
residues)

Shows the number of bases marked by an asterisk over the consensus 
sequence data. 

A base position marked by an asterisk functions as a discriminatory residue. 

A base position is considered a discriminatory residue if all the included 
sequences (checkbox is selected) have the same residue in this position, and 
if none of the excluded sequences (checkbox is deselected) have the residue 
in this position.

Call 
Out Feature Description
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Working With Sequences

Introduction This section describes how to import, enter, lock and unlock, edit, and 
annotate a sequence.
(

Importing a
Sequence

General Information

You can import a sequence into the Primer Express software using the 
PC dialog box file navigation.

Using the Traditional Dialog Box File Navigation

To import a sequence file using the traditional dialog box file navigation.

Using the Drag-and-Drop Feature

To import a sequence file using the drag-and-drop feature.

Step Action

1 Click the button labeled Import DNA File (for DNA files) or Import 
Alignment File (for Allele Specific PCR documents).

2 Navigate to the Primer Express software Sample Sequences folder 
or any other folder containing sequence or alignment files. 

For a list of compatible file types, see “File Types Supported” on 
page C-1.

3 Highlight the name of the sequence file to select it, then click Open 
to import the sequence into the Sequence page (or double-click the 
file name).

If you are working in a Multiplex PCR document, you can create a 
multiplex set by importing multiple sequences into the same 
document. 

4 Repeat the procedure above to import multiple sequences into a 
Multiplex PCR document.

Step Action

1 Position the Primer Express document window on the screen so 
that the Sequence page is visible when you return to the Finder.

2 Locate the sequence(s) you wish to import into the Primer Express 
document.

3 Drag a sequence or folder icon directly onto the Primer Express 
software Sequence page.
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Entering a
Sequence

General Information

If you prefer to enter a sequence using the keyboard, type the 
sequence letters or paste from the clipboard (except in the Allele 
Specific document; see paragraph below). You can enter any IUPAC 
standard characters into the Sequence page. See Appendix F, “IUPAC 
Codes,” for a complete listing of the IUPAC character set.

Note You cannot type modified bases (for example, methylated C) into the 
Sequence page.

Allele Specific PCR Document

You cannot type a sequence into the Allele Specific PCR Sequence 
page. However, the Primer Express software recognizes Sequence 
Navigator files, which is a standard interchange format for DNA 
sequence alignments.

Multiplex PCR Document

You cannot type multiple sequences directly into a Multiplex PCR 
document. To enter more than one sequence in a Multiplex PCR 
document, create separate text files using a word processor, then 
import the text files into the Sequence page of the Multiplex PCR 
document. Alternatively, you can use the PRIMER format for 
designating multiple sequences in a single text file. For more 
information, see “Imported Sequence Files” on page C-2.

How to Enter and Name a Sequence

To enter and name a sequence.

Step Action

1 Type or paste the sequence text.

2 Press the Tab key to select the file name data field.

3 Type the name under which you wish to save the Primer Express 
document.

4 Press Ctrl-S to save the document, or select Save from the File 
menu.
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Locking and
Unlocking a

Sequence

General Information

When you import a sequence into the Sequence page, the sequence 
text is locked to prevent you from accidentally modifying or deleting 
sequence text. If you wish to make changes to the sequence text or to 
drag a portion of the sequence text into a clipping file, unlock the 
sequence data before proceeding.

How to Unlock the Sequence Text

To unlock the sequence text, click the lock icon ( ) in the upper left 
corner of the sequence page. When the sequence text is unlocked, the 
icon turns into the unlock icon ( ).

Note If you delete all the text of an imported sequence, you cannot import 
another sequence file. You must open a new document in order to import 
another sequence.

Editing a Sequence General Information

Standard Windows Cut, Copy, and Paste commands are available for 
working with Sequence data.

Note You cannot modify or remove an alignment file imported into an Allele 
Specific document. To use a different alignment file, you must create a new 
Allele Specific document.
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How to Copy Sequence Text

How to Add Data to a Sequence

How to Remove Data from a Sequence

Step Action

1 Click anywhere in the sequence text to remove any text 
highlighting.

2 Click and drag over the area you want to copy so that the data is 
highlighted.

3 From the Edit menu, select Copy.

4 The sequence data is copied onto the clipboard and is ready for 
pasting.

Step Action

1 Unlock the sequence data. 

For more information on unlocking the sequence data, see “Locking 
and Unlocking a Sequence” on page 5-13.

2 Place the mouse pointer over the location you would like to make 
the addition.

When you move the cursor over the text in the Sequence page, the 
arrow cursor ( ) changes to an I-beam cursor ( ) similar to that 
used in many word processing programs.

3 Click the mouse button to fix the cursor in that location.

4 Type or paste the sequence data you wish to add.

Step Action

1 Unlock the sequence data. 

For more information on unlocking the sequence data, see “Locking 
and Unlocking a Sequence” on page 5-13.

2 Click anywhere in the sequence text to remove any text 
highlighting.

3 Click and drag over the area you want to remove so that the data is 
highlighted .

4 From the Edit menu, select Cut or Clear (or you can press the 
Delete key).
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How to Completely Remove the Current Sequence Data

Annotating a
Sequence

You can mark (annotate) sequence data to control the location of 
primers and to highlight features of importance, such as intron-exon 
junctions, excluded regions, and so on. For information about 
annotating a sequence, see Chapter 6, “Using the Annotation Tools.”

5 If you make a mistake, select Undo from the File Menu.

Note The Undo/Redo affects only the single most recent action in 
the Primer Express software.

Step Action

1 Unlock the sequence data. 

For more information on unlocking the sequence data, see “Locking 
and Unlocking a Sequence” on page 5-13.

2 From the Edit menu, choose Select All to select all the current 
sequence data.

3 Press the delete key to remove all sequence data from the 
Sequence page.

Note If you delete all the text of an imported sequence, you 
cannot import another sequence file (the Import DNA button is 
dimmed). You must open a new document in order to import a 
sequence.

Step Action
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How to Find Primers

Introduction Depending upon the power of your computer, the document type, the 
size of the sequence(s), and the quantity of annotations, the Primer 
Express software can take from one second up to several minutes to 
find primers. The status bar at the bottom of the Primer Express 
software window displays the progress of the calculations.

After the Primer Express software performs the calculations, one of two 
events occurs, either the software

� Finds primers

� Does not find any primers

When the Primer
Express Software

Finds a Primer

When the Primer Express software finds primers, the highest-ranking 
primer set is displayed on the Sequence page (Figure 5-1). The ranking 
is determined by Penalty score. For more information about Penalty 
Score, see Appendix B, “Calculating Penalty Score.”

Figure 5-1 Sequence page showing primer set

Forward primer

Reverse primer
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When a Primer Set
is Displayed

Colored Outline Arrows

When a primer set is displayed on the sequence page, the entire 
amplified region is highlighted, and the two primers are indicated by 
colored outline arrows. Red arrows indicate that the primers are 
considered optimal. For more information about Optimal Primers, see 
“How to Find Primers” on page 5-16.

Information Displayed in the Status Bar

The status bar displays the number of primer pairs found, up to a 
maximum of 200 primer pairs. If 200 pairs are found, then they are 
those 200 that have the lowest penalty scores of all possible pairs (for 
more information about penalty scores, see Appendix B, “Calculating 
Penalty Score.”)

The complete set of primers found is listed on the Primers and Map 
pages. If you are dissatisfied with the number of primer pairs found, you 
may make sequence annotations or change parameters on the Rxn 
Cond or Params pages.

For information about

� Making sequence annotations, see “Annotating a Sequence” on 
page 5-15.

� Changing parameters, see on page 5-28. “Standard Parameters 
Page” on page 5-19, or the “Reaction Conditions Page” on 
page 5-30.
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When the Primer
Express Software

Does Not Find
Primers

When the Primer Express software does not find primers, the status bar 
displays the message “No Acceptable Primer Pairs Found.” 

To generate primers, make one or more of the following changes:

� Change one or more parameters on the Params page. Start by 
relaxing the Tm and Primer Length parameters. For information 
about changing parameters, see “Standard Parameters Page” on 
page 5-19.

� Import a different sequence by opening a new Primer Express 
document.

� Erase or change one or more sequence annotations. For 
information about making sequence annotations, see “Annotating a 
Sequence” on page 5-15.
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Standard Parameters Page

About the Page The Standard Parameters page allows you to view and modify 
parameters controlling primer and amplicon Tm, GC content, length, 5´ 
tail, composition, uniqueness, and secondary structure.

DNA PCR
Parameters Page

Example

The following is an example of the DNA PCR Parameters page with  
default values.
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Features The following table describes the features in the DNA PCR Parameters 
page. The data fields included on the Standard Parameters page can 
vary, depending upon the document type.

Feature Description

Primer Tm 
Requirements

Parameters that control primer Tm are contained in this 
pane of the Parameters page. These parameters are used 
to calculate primer pairs. 

These parameters are:

� The Min Tm (default=57 °C) and Max Tm (default=63 °C) 
parameters display as horizontal dotted lines in the 
Feature Map on the Map page (see “Map Page 
Example” on page 5-38). 

� The maximal Tm difference parameter (default=2 °C) 
controls the difference between the Tms of the forward 
and reverse primers in a primer pair. 

Primer GC 
Content 
Requirements

Parameters that control GC content are contained in this 
pane of the Parameters page. 

The Min%GC (default=45) and Max%GC (default=55) data 
fields set the boundaries of the %GC. 

The GC Clamp data field (default=0) sets the number of G 
or C residues required at the 3´ end of the primers. 
Although you can set the GC Clamp value to any value, 
using a value greater than 3 generally causes no primers to 
be calculated.

Primer Length 
Requirements

Parameters that control primer length are contained in this 
pane of the Parameters page. 

The Optimal length parameter (default=20) is used, along 
with the Optimal Tm parameter, to determine whether a 
primer pair is considered optimal. 

Optimal primer pairs are those whose Tm and length are 
within 1 unit of the value entered on the Parameters page.
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5´ Tail 
Forward
/Reverse 
Primers

The 5´ Tail fields allow you to specify a 5´ tail on either 
primer. 

Type the desired sequence in the data entry field, up to a 
maximum of 255 IUPAC characters, to activate this feature.

If a 5´ tail is entered, two Tms are calculated for that primer: 
one Tm for the sequence-specific primer and one Tm for the 
tailed primer. The Tms calculated are displayed in three 
locations:

� In the Primer Data window (see “Show/Hide Primer 
Data” on page 7-15).

� In the Primer Display pane of the Primers page.

� On the Map page.

In all locations, Tm data is displayed as a double number 
separated by a virgule (forward slash), for example: 60/76.

Amplicon 
Requirements

Parameters that control amplicon Tm and length are 
contained in this pane of the Parameters page.

More Params/
Fewer 
Params 
button

Toggles the Parameters page between the Fewer Params 
display and the More Params display. For more 
information, see “More Parameters” on page 5-22.

Because more text and data fields must fit into the same 
space, the text is smaller and has less space. For more 
information, see Figure 5-2.

Feature Description

IF you are in... THEN...

Fewer Params mode only the primary 
parameters are 
displayed.

More Params mode all primary and 
secondary parameters 
are displayed 
(Figure 5-2).
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More Parameters On all PCR document types except Multiplex PCR and Allele Specific 
PCR, you can toggle the Parameters page between two displays using 
the More Params/Fewer Params button (see “More Params/ Fewer 
Params button” on page 5-21). The features described in this section 
are available only when More Params are displayed.

The following table lists the additional parameters that are displayed 
when you click the More Params button (see Figure 5-2 on page 5-22).

Figure 5-2 Params page with More Params displayed

Defaults 
button

Resets the numbers in the data fields to the user-selected 
default values set in the Preferences window. 

For more information, “Preferences Command” on 
page 7-13.)

Factory 
Defaults 
button

Resets the numbers in the data fields to the original factory 
default values.

Feature Description

Feature Description

Primer 
Composition 
Requirements

Parameters that control the maximum number of 
repeated G bases (default=2) and the maximum 
number of ambiguous bases (default=0) allowed in 
each primer.
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Primer Secondary 
Structure 
Requirements

Parameters that pane control the maximum number 
of consecutive base pairings (default=4) and 
maximum number of base pairings (default=8) 
allowed. Base pairings cause hairpin loops to form.

Primer Site 
Uniqueness 
Requirements

Parameters that control the degree of similarity a 
primer has to any other region of the sequence.

� Max Consec Match—controls the maximum 
number of consecutive primer residues that match 
any other region (default=9).

� Max % Match—controls the maximum allowable 
percentage of primer sequence that matches any 
other region (default=75).

� Max 3' Consec Match—controls the maximum 
number of consecutive primer residues at the 3' 
end that match any other region (default=7).

Feature Description
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How to Set Parameters

Primer Design
Strategy

When starting an oligo design, it is best to start with the default 
parameters until you have experience using the Primer Express 
software. After you evaluate the primer pairs found using the default 
parameters, then you can begin to modify one parameter at a time, 
evaluating each time the effect of the previous change on the primer 
selection. Use the Interim Results window to guide you. For more 
information, see “Show/Hide Interim Results” on page 7-15.

Setting Parameters To set parameters:

Step Action

1 Highlight the data entry field you wish to change or press the Tab 
key to move from field to field. 

The Reaction Conditions page also contains values that affect 
primer calculations. For more information, see “Features” on 
page 5-31.

2 Type the value you wish to enter into the data field.

Note You cannot enter a minimal or optimal parameter value 
greater than the current maximal parameter value.Similarly, you 
cannot enter a maximal or optimal parameter value less than the 
current minimal parameter value. To change parameters this 
drastically, you must change them in the correct order.

3 Select Find Parameters Now from the Options menu.

4 On the Primers page or Map page, view the new selection of primer 
pairs generated by your parameter change.

5 On the Primers page, view the Interim Results (pull down the 
Options menu and select Show Interim Results) to help you 
determine the reason for the number of primers found. 

For a description of the tests that produce the Interim Results, see 
Appendix A, “Interim Results Window.”

6 Repeat this procedure until you get the selection of primer pairs you 
desire.
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Parameters Page: Multiplex PCR

About the Page The Parameters page for the Multiplex PCR document is different in 
several ways. Unlike most other Primer Express documents, the 
Multiplex PCR Parameters page does not have a Fewer Params option 
because of the many parameters required to set up a Multiplex PCR 
document. The Multiplex PCR Parameters page also contains a Primer 
End Composition pop-up menu.

Multiplex PCR
Parameters Page

Example

The following is an example of the Parameters page for Multiplex PCR.
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Features The following table lists the features for the Parameters page for 
Multiplex PCR. For a description of the complete set of parameters 
available, see “Standard Sequence Page” on page 5-4.

Feature Description

Max TM Difference 
Among Sets

Sets the maximal difference among any set of two 
primers, which guarantees that all primer pairs in the 
Multiplex PCR have similar Tms (default = 3 °C).

Primer End 
Composition

The Last four positions contain pop-up menu provides 
four options that help to avoid 3'-end complementarity 
by controlling the makeup of the final four bases in the 
primers.

Choose one of the following four options:

� Maximal G + A, Low T, No C (default)

� Maximal G + T, Low A, No C

� Maximal C + A, Low T, No G

� Maximal C + T, Low A, No G

Controlling the base composition at the 3' ends allows 
you to prevent the possibility of primer-dimer 
formation among any of the primers in the reaction. 

No one option is necessarily better than the others; 
base the option you choose on the DNA template 
sequence and the parameters. Try all four options to 
determine which works best in each case.

Amplicon Min 
Spacing

Sets the minimal amount of difference between the 
lengths of any two amplicons. 

This ensures that the amplicon lengths are different 
enough so they are distinguishable by electrophoresis 
(default = 8 bases).
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Parameters Page: Allele Specific PCR

About the Page The Parameters page for the Allele Specific document is identical to the 
“More Params” page for a DNA PCR document. Unlike most other 
Primer Express documents, the Allele Specific PCR Parameters page 
does not have a Fewer Params option because of the many parameters 
that are required to set up an Allele Specific PCR document.

Allele Specific
Document

Parameters Page
Example

The following is an example of the Parameters page for the Allele 
Specific document.

Features For a description of the complete set of parameters available, see 
“Standard Sequence Page” on page 5-4.
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Parameters Page for the TaqMan Probe

About the Page The Parameters page for the TaqMan Probe document is similar to the 
Parameters page of a DNA PCR document, except that the 5' Tail 
criteria are replaced with TaqMan probe criteria.

TaqMan Probe
Document

Parameters Page
Example

The following is an example of the Parameters page for the TaqMan 
Probe document.

Features TaqMan Probe parameters page features. 

Feature Description

TaqMan Probe 
Criteria

A data entry field allows you to select the temperature 
spread between primer Tm and probe Tm. The default 
value is ten degrees.

A checkbox allows you to select whether the TaqMan 
probe begins with a G.

Other Params For descriptions of the remaining parameters, see 
“Standard Sequence Page” on page 5-4.
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Parameters Page for Sequencing

About the Page The Parameters page for Cycle Sequencing and Sequencing Primer 
documents contains several parameters unique to the sequencing 
applications. Unlike most other Primer Express documents, the 
Parameters page for Sequencing documents does not have a Fewer 
Params option because of the many parameters that are required to set 
up a Sequencing document.

Parameters Page
for Sequencing

Documents
Example

The following is an example of the Parameters page for Sequencing 
documents.

Features The Primer Position Requirements field allows you to set the primer 
position relative to the end of the sequence.

For a description of the complete set of parameters available, see 
“Standard Sequence Page” on page 5-4.
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Reaction Conditions Page
‘

About the Page The Reaction Conditions page allows you to set the concentrations of 
the template DNA, primers, salt, and magnesium in the PCR reaction. 
You can also select from four different PCR enzymes. The salt and 
magnesium values affect the Tms of primers calculated.

Reaction
Conditions Page

Example

The following is an example of the Reaction Conditions page with 
default values.

Pop-up menus
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Features The following table lists the features of the Reaction Conditions page.

Feature Description

PCR Enzyme 
pop-up Menu

You can select from four PCR enzymes that affect the 
quality (primarily in terms of Tm) of the PCR primers. Each 
PCR enzyme has specific salt and MgCl2 (magnesium 
chloride) requirements and is used for a different type of 
PCR application. Selecting a PCR enzyme option changes 
the values displayed in the Salt and Mg++ data fields.

For a more detailed discussion of each enzyme, see 
Appendix D, “PCR Enzymes and Primer Express.”

Template DNA 
Concentration

The molecular weight pop-up menu is a quick way to 
specify one of several common template DNA types. This 
pop-up menu has six options:

� As entered from sequence data (default)

� Phage Lambda (3.2 X 107 Daltons)

� E. Coli (3.1 X 109 Daltons)

� Yeast (9.8 X 109 Daltons)

� Drosophila (9.1 X 1010 Daltons)

� Human (2.2 X 1012 Daltons)

Forward/Reverse 
Primer 
Concentrations

The primer concentrations directly affect the Tm of all 
primers calculated, that is, as the primer concentration is 
increased, the corresponding primer Tms increase.

Three linked data entry fields allow you to enter primer 
concentrations in any of the following scales: OD260, 
µg/ml, or nM.

Salt The salt concentration value directly affects the Tm of all 
primers calculated, that is, as the salt concentration is 
increased, the corresponding primer Tms increase.

Mg++ The Mg++ concentration value is passed on to the Recipe 
page, but not used in calculating Tm values. For further 
information, see “Standard Recipe Page” on page 5-44.

Defaults button Resets the numbers in the data fields to their original 
(default) values. You can set these default values in the 
Preferences dialog box. For more information, see 
“Preferences Command” on page 7-13.

Help button Provides specific help for the Rxn Cond page from the 
Primer Express Guide online help facility. 
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Setting Reaction
Condition Values

The following procedure describes how to set reaction condition values.

Step Action

1 Highlight the data entry field you wish to change. 

The Parameters page also contains values that affect primer 
calculations. For more information, see “Standard Parameters 
Page” on page 5-19.

2 Type the value you wish to enter into the data field.

3 Select Find Primers Now from the Options menu.

4 On the Primers page or Map page, view the new selection of primer 
pairs generated by your parameter change.

5 Repeat this procedure until you get the selection of primer pairs you 
desire.
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Primers Page

About the Page The Primers page displays the results of a primer calculation using the 
data contained in the Parameters and Reaction Conditions pages.

Primers Page
Example

The following is an example of the Primers pages showing calculated 
primers.

Sort headings 
(toggle 
switches)

Primer 
Data 
window

Primer 
Display 
pane

Scroll bar
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Features The following table lists the features of the Primers page.

Feature Description

Primer 
Display 
Pane

Scrolling pane that contains the Start, Length, Tm, %GC, and 
primer sequence data for both primers and amplicon. 

A separate heading at the right of the Primer Display pane 
shows the Penalty score. For more information, see 
Appendix B, “Calculating Penalty Score.” 

You can sort the data in this pane by any of the headings 
(see “How to View the Window” on page 5-36).

Order 
button

Displays an electronic form for ordering primers 
electronically. For more information, see “How to Order 
Primers” on page 5-37.

Save List 
button

Saves the primer numerical and sequence data in a text file 
on your hard disk. For more information, see “Table of 
Exports Files” on page C-3.

Display 
button

Allows you to show or hide the display of one or more data 
fields on the Primers page. Click the button to display the 
Primers Page Display Controls window. Click any heading to 
toggle the display between visible and hidden.

Hidden data 
fields
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Primer Data
Window

General Information

The Primer Data Window is a small window that contains the primer 
sequence and attributes for the primers selected (highlighted) in the 
Primers page. You can view the Primer Data window when the 
Sequence, Params, Primers, or Map page is active, and the Primer 
Data Window varies according to which document type you are using.

Note The Batch Processing document, the Primer Test document, and the 
TaqMan MGB Test document do not have a Primer Data window.

Primer Data
Window Examples

The following are examples of the Primer Data window.

DNA PCR, RT PCR, Allele Specific PCR

Nested PCR

 TaqMan PCR
Cycle sequencing, Sequencing Primer
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How to View the
Window

To view the Primer Data window, select Show Primer Data from the 
Options menu.

Features of the
Primer Data

Window

Primer Data window features.

Viewing
Parameters

Any primer pairs found as a result of a search are displayed in the 
upper pane of the Primers page. The primers displayed are sorted 
according to the heading that is underlined near the top of the page 
(see “Display button” on page 5-34, the results are sorted from low to 
high based on starting location). The default sorting parameter is by 
Penalty score. For more information, see Appendix B, “Calculating 
Penalty Score.”

The following table lists the actions that you can take.

Feature Description

Forward/Reverse 
Primer Sequence Data

This pane in the Primers page shows the 
sequence of bases contained in the forward and 
reverse primers, along with the Tm, %GC, starting 
location, and primer length.

Amplicon Data This pane in the Primers page shows the Tm , 
%GC, length, and Ta of the amplicon.

To Take this action Comment

change the sort 
order of the 
results

Click any heading to 
toggle the display from 
low-to-high or 
high-to-low

You can use the headings named 
Start, Length, Tm, %GC, and 
Penalty to sort the primer results.

view only the 
optimal primer 
results

Select the checkbox 
labeled Optimal Only

 Optimal results are calculated 
based on the values entered by 
you (or the default) in the 
Parameters page under Optimal 
Tm and Optimal Length.

view interim 
results of a variety 
of primer 
calculations

Select Show Interim 
Results from the 
Options menu

For more information, see 
“Show/Hide Interim Results” on 
page 7-15.
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Saving the List of
Primers

To save the primer results, click the button labeled Save List. Primer 
results are saved to your hard drive as tab-delimited ASCII text 
(unformatted) suitable for importing into a spreadsheet application.

How to Order Primers

Ordering Primers Pressing the Order button displays a text window, from which you can:

� Modify the text.

� Copy and paste the text into your regular electronic mail program.

� Use the Save As command to save the text as a file. You can use 
this file as an attachment in your electronic mail program.

� Print the document and fax it.
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Map Page

About the Page The Map page displays a graphical view of all primer pairs found, along 
with graphs for Tm, %GC, and all sequence annotations. For a 
description of the Map page for Nested PCR, see “Map Page for Nested 
PCR” on page 5-44.

Map Page
Example

The following is an example of the Map page with a number of 
annotations displayed.

Primer pane

6.Reverse Primer 3' End      
annotation

7. ORF annotation
8. Scale Control
9. Scroll bars

Feature Map

1. Tm and GC plots

2. Exclude Region annotation
3. Site annotation
4. Forward Primer annotation

5. Target Region annotation

1

2 3
5 6 7

8
9

4
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Features The following table lists the Map page features.

Feature Description

Feature Map The Feature Map is located at the top of the Map 
page and shows a capsule view of the sequence 
features, including Tm plot, GC plot, and the 
Annotation Bar.

Tm Plot The Tm plot displays in magenta at the top of the Map 
page Feature Map. It is displayed by default when 
you view the Map page for the first time. 

To toggle the Tm plot on or off, click the Tm Plot 
checkbox.

The Tm plot is composed of four components 
(Figure 5-3): 

� Tm scale—shows the values that the Tm min/max 
lines and Tm plot lines have at any point in the 
display. 

The Tm horizontal scale changes along with the 
scale of the primer pair graphics in the Primer 
pane at the bottom of the Map page.

� Tm maximal

� Tm minimal

� Tm plot line—shows a running graphic display of 
the primer Tm, using a calculation window defined 
by the value entered for optimal primer length 
(default=20). 

Figure 5-3 Features of the Tm Plot

Tm plot line

Tm Plot

checkbox

Tm min/max linesTm scale

Number of 
nucleotides in 
sequenceAnnotation bar
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GC Plot The GC plot displays in green at the top of the Map 
page feature map. Click the GC Plot checkbox to 
toggle the GC plot on or off.

The GC plot is composed of four components 
(Figure 5-4): 

� GC scale—shows the values that the GC min/max 
lines and GC plot lines have at any point in the 
display. 

The GC horizontal scale changes along with the 
scale of the primer pair graphics in the Primer 
pane at the bottom of the Map page.

� GC maximal

� GC minimal

� GC plot line—shows a running graphic display of 
the sequence GC percentage. 

Figure 5-4 Features of the GC Plot

Annotation Bar The annotation bar is the black horizontal line located 
at the bottom of the Feature Map, upon which 
representations of the sequence annotations are 
displayed. 

Each sequence annotation displays in a color 
identical to its counterpart annotation on the 
Sequence page. 

The table below shows the relationship between the 
annotation graphics on the Sequence page and its 
counterpart in the feature map on the Map page.

Feature Description

GC plot line

GC Plot checkbox
GC min/

max lines

GC scale

Number of nucleotides in 
sequence
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Scroll Bars Two scroll bars let you view primer pair graphics that 
are outside the viewing area of the Primer pane.

Feature Description

Annotation
Sequence page 
description Map page description

Target Region green lower case 
text

green outline around region

Exclude Region red line through 
text

red solid box through region

Forward Primer light blue arrow ↓ light blue solid arrow ↓

Forward Primer 
End

light blue dashed 
arrow ↓

light blue dashed arrow ↓

Reverse Primer light blue solid 
arrow ↑

light blue solid arrow ↑

Reverse Primer 
End

light blue dashed 
arrow ↑

light blue dashed arrow ↑

ORF red 3-letter AA 
designations

red outline arrow

Line magenta line 
under text

magenta outline around 
region

Junction dark blue line 
under 2 bases

dark blue solid small box

Site dark blue arrow 
with site name

dark blue arrow with site 
name
Primer Express Pages 5-41



Primer Pane About the Primer Pane

The Primer pane is the lower pane in the Map page and displays a 
graphic for each primer pair found by the Primer Express software. 
Several different numerical attributes are shown next to each primer 
pair graphic (Figure 5-5).

Figure 5-5 Primer pair graphic

Sorting the List

You can sort the list of primer pair graphics by any of the attributes. The 
current sort is shown by the attribute being underlined. Click on the 
attribute to toggle the sort between a low-to-high or high-to-low sort.

Forward 
primer start 
location

Forward primer Tm Reverse primer Tm

Reverse 
primer start 
location

Amplicon length

Forward primer Reverse primer

Amplicon
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Scale Control
Buttons

You can change the scale (magnification) of the display using the scale 
controls located at the bottom left of the Map page. 

The following table describes how to use the scale controls.

IF you want to... THEN click the...

Zoom in plus sign (+) 

Zoom out minus sign (–)

Select the scale a. Click and hold the view scale.

The pop-up menu appears.

b. Select the desired scale from the 
pop-up menu.
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Map Page for Nested PCR

About the Page The Map page for a Nested PCR document graphically shows both the 
external and internal primer pairs.
\

Map Page
Example

The following is an example of the Map page for Nested PCR 
documents.

Sorting the Primer Click any of the attributes shown in the Primer pane to sort the primer 
pair graphics (Figure 5-6) by that attribute. All the other features of the 
Nested PCR Map page function identically with the standard Map page.

Figure 5-6 Nested PCR graphics

External primer pair

Internal primer pair

External primer pair

Internal primer pair
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Standard Recipe Page

About the Page The Standard Recipe page lets you calculate the amount of the 
components you need for different PCR reactions, starting from a given 
stock concentration. The Standard Recipe page is a part of the 
following document types: DNA PCR, RT PCR, Nested PCR, Allele 
Specific PCR, Multiplex PCR, and TaqMan probe.

The Standard Recipe page functions as a spreadsheet: when you 
change a value in the Stock Concentration column (on the left), the 
associated Final Concentration value is calculated and displayed (on 
the right).

Standard Recipe
Page Example

The following is an example of the Standard Recipe page with default 
values.
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Features Standard Recipe page features:

Creating the
Reaction Protocol

To create the reaction protocol.

Feature Description

Stock 
Concentrations 
column

Contains the concentrations of the stock solutions 
used to create the PCR mixture. 

The last two components on the page are user 
definable. This feature lets you add something extra 
to your protocol. These extra additions are typically 
enzymes or proteins such as BSA, UNG, dUTP, or 
gelatin.

Volume column Shows the volume of each component to add to the 
reaction to achieve the final concentration.

Final Concentration 
column

Contains the desired final concentrations for the PCR.

Reaction Volume Volume required for the reaction (default=100 µL).

Number Tubes Number of reaction tubes you use for the PCR 
(default=1).

Pipeting Excess Quantity of extra mixture you want to create in order 
to have some to spare. 

This quantity is also known as slop factor. The 
number entered is a percentage of the reaction 
volume (default= 20%).

Protocol pop-up 
Menu

Lets you select the correct protocol for your PCR 
Amplification, Magnesium Titration, or Polymerase 
Titration.

Step Action

1 Verify or modify the data contained in the data fields on any Recipe 
page to reflect the correct proportions of reaction components.

2 Select the protocol type from the Protocol pop-up menu.

3 Click the Create Protocol button to display the protocol text file.

4 Print the protocol for your records.
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Recipe Page for Cycle Sequencing

About the Page Use the Recipe page for Cycle Sequencing with the ABI PRISM™ Taq 
Terminator Ready Reaction Kit. This page functions like the Standard 
Recipe page (“Standard Recipe Page” on page 5-45) but contains 
recipe components for the Cycle Sequencing application.

Results Page
Example

The following is an example of the Recipe page for Cycle Sequencing.
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Features The following table lists the features of the Results page.

Feature Description

Stock 
Concentrations 
column

Contains the concentrations of the stock solutions 
used to create the PCR mixture for cycle sequencing. 

The last two components on the page are user 
definable. This feature lets you add something extra 
to your protocol. These extra additions are typically 
enzymes or proteins such as BSA, UNG, dUTP, or 
gelatin.

Template pop-up 
Menu

Lets you select from single-stranded (ss), 
double-stranded (ds), or PCR product template. 

Each template specifies its own concentration for the 
cycle sequencing reaction.

Reaction Volume Volume required for the cycle sequencing reaction 
(default = 20 µL).
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Recipe Page for Sequencing Primer

About the Page The Recipe page for Sequencing Primer functions like the Standard 
Recipe page (“Standard Recipe Page” on page 5-45) but contains 
recipe components for the Sequencing Primer application.

Recipe Page
Example

The following is an example of the Recipe page for Sequencing Primer.

Features Sequencing Primer Recipe page features.

Feature Description

Stock 
Concentrations 
column

Contains the concentrations of the stock solutions used to 
create the PCR mixture for sequencing primers.

Change these concentrations to match the requirements of 
whatever kit you are using for sequencing.

The last two components on the page are user definable. 
This feature lets you add something extra to your protocol. 
These extra additions are typically enzymes or proteins such 
as BSA, UNG, dUTP, or gelatin.

Reaction Volume Volume required for the cycle sequencing reaction 
(default = 10 µL).
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Results Page

About the Page General Information

The Results page gives you a way to save the results of your actual 
PCR experiment. After you design and select primers using the Primer 
Express software, then use the primers in the PCR experiment, return 
to the Results page to enter the results of the PCR.

The information in the Results page is saved in the archive file you 
created when you started the Primer Express software for the first time 
(default=PXArchive).

When this Page is Useful

For example, the Results page is useful if a number of different people 
in the lab are working on the same gene sequence. The data from the 
Results page tells you whether someone else has already made a 
primer set to amplify a region of interest and how well their primers 
worked.

Results Page
Example

The following is an example of the Results page.
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Features The Results page contains a number of data fields, some of which 
contain data generated by the Primer Express software, the remainder 
are available for user input.

The following table lists the features of the Results page:

.

Feature Description

Sequence Displays the name of the sequence imported into the 
Primer Express software. If you have not imported a 
sequence file, the message, No File Loaded, 
appears.

User Displays the name of the registered user whose PC 
computer is being used to run the Primer Express 
software.

Forward Primer Displays the sequence of bases that make up the 
forward primer.

Reverse Primer Displays the sequence of bases that make up the 
reverse primer.

Hybridizing At Displays the numerical locations indicating the primer 
5'- and 3'-end bases.

Tm These two fields display the Tms of their associated 
primers.

Cycle Params This section of the Results page contains nine 
parameters that describe the PCR cycles. 

The pop-up menu allows you to choose from two-step 
or three-step PCR. 

The data fields let you enter time, temperature, and 
concentration parameters. 

The checkbox indicates that you used a hot start.

Concentrations This section of the Results page contains four data 
fields that allow you to set the Template DNA, Primer, 
Salt, and Mg concentrations.

Save Results 
button

Saves the data on the Results page in the Results 
Archive. For more information, see “Open Results 
Command” on page 7-4.
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Results Page for Nested PCR

About the Page The Nested PCR document generates two pairs of primers, an external 
pair and an internal pair. The Results page for a Nested PCR document 
contains data fields for both pairs of primers, but otherwise conforms to 
the standard Results page layout.

Results Page
Example

The following is an example of the Results page for the Nested PCR 
document.

Annotating Your
Results

If your PCR is more complicated than the Results page allows you to 
describe, add your specific data in the Comments box. 

To enter data, click the mouse in the Comments data field, then type 
your comments. The Comments box holds up to four lines of text.

Saving Your
Results

You can save the contents of the Results page for future reference by 
clicking the Save Results button. All the Primer Express software data, 
including saved results information, is stored in the Primer Express 
software Archive file (default name=PXArchive). 
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Viewing and
Modifying Saved

Results

To view or modify saved results, choose Open Results from the File 
Menu. For more information, see “Open Results Command” on 
page 7-4.

Other Primer Express Software Views

Batch Processing For a description of the Batch Processing document features, see 
“Batch Processing Document” on page 4-61.

Primer Test For a description of the Primer Test document features, see “Primer 
Test Document” on page 4-67.
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6
Using the Annotation 
Tools 6

Introduction

In This Chapter Topics in this chapter include the following:

Topic See page

About the Annotation Tools 6-2

Selecting and Moving Sequence Text 6-4

How to Delete Annotations 6-5

How to Specify a Sequence Region 6-6

How to Specify Where the Probe Must Anneal 6-8

How to Exclude a Sequence Region 6-10

How to Select a Forward Primer Region 6-12

How to Set a Sequence Residue as the Forward Primer End 6-14

How to Set a Sequence Region as the Reverse Primer 6-16

How to Select a Sequence Region as Reverse Primer End 6-18

How to Translate DNA to Amino Acid Sequence 6-20

How to Highlight Sections of Sequence Text 6-22

How to Create a Junction Annotation 6-24

How to Create Restriction Enzyme Site 6-26
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About the Annotation Tools

Introduction The Primer Express® software provides 12 tools to annotate the 
sequence you have entered or imported into a Primer Express 
document. The annotation tools are available on a movable palette.

Annotation Tool
Palette

The following is an example of the annotation tool palette.

* Changes to the Probe Tool in a TaqMan® Probe document

Eraser Tool

Exclude Region Tool

Forward Primer End Tool

Reverse Primer End Tool

Line Tool

Site Tool

Select Tool

Target Region Tool*

Forward Primer Tool

Reverse Primer Tool

ORF Tool

Junction Tool
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Tool Groupings There are two groupings of annotation tools: those that do not affect 
primer calculations and those that recalculate primers. The following 
table lists the two groupings of the annotation tools palette.

Moving the Palette To move the palette, drag the palette title bar to a different location on 
the desktop.

To... Use these tools...

not affect primer calculations � Select

� ORF

� Line

� Site

recalculate primers, if AutoFind is 
On (see “Turn AutoFind ON/OFF” on 
page 7-14).

� Eraser

� Target

� Exclude

� Forward Primer

� Forward Primer End

� Reverse Primer

� Reverse Primer End

� Junction
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Selecting and Moving Sequence Text

Introduction Use the Select tool to select and copy sequence text, as well as 
modifying annotations.

Selecting Sequence
Text

When you move the cursor over the text in the Sequence page, the 
arrow cursor ( ) changes to an I-beam cursor ( ) similar to that used 
in many word processing programs. 

To select sequence text, click and drag to highlight the desired data. 
Once sequence text is selected, you can cut or copy the text using 
standard PC commands, or you can copy the text into a clipping file.

Modifying an
Annotation

You can use the Select tool to move, lengthen, or shorten existing 
annotations. The following procedure describes how to modify an 
annotation.

To modify an annotation:

Step Action

1 Click the Select tool on the tool palette.

2 If any sequence text is highlighted, click anywhere in the text to 
eliminate the highlighting.

Note You cannot modify an annotation when any sequence text is 
highlighted.

3 Position the Select tool cursor over the beginning or end of the 
annotation.

4 When in the correct position, the arrow or I-beam cursor changes to 
the transparent open hand cursor ( ).

5 Click and hold the cursor. 

The end piece of sequence data highlights with a small highlight 
box.

6 To move or change the length of the annotation, drag the highlight 
box in any direction.
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Removing an
Annotation

You can remove many (but not all) annotations by using the Select Tool. 

To remove a Target, Exclude, Forward Primer, Forward Primer End, 
Reverse Primer, Reverse Primer End, ORF, or Line annotation, drag 
one end of the annotation past the opposite end.

Note Select Clear All Annotations from the Edit menu to remove all existing 
annotations at the same time.

How to Delete Annotations

Deleting
Annotation

Use the Eraser tool to delete annotations from Primer Express 
documents.

To delete an annotation, click the bottom left corner of the Eraser cursor 
on the annotation you wish to delete.

Note You can also use the Select tool to delete many annotations. For more 
information, see “Removing an Annotation” on page 6-5.

Removing All
Annotations

To remove all existing annotations at the same time, select Clear All 
Annotations from the Edit menu.
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How to Specify a Sequence Region

Introduction Use the Target Region tool for specifying a particular sequence region 
that you want amplified by the PCR reaction.

Note Only one Target annotation is allowed in each Primer Express document 
(except Multiplex PCR). Creating a new Target annotation automatically deletes 
any existing one, as well as deletes any incompatible forward or reverse primer 
annotations.

Adding a Target
Annotation

To add a target annotation.

Step Action

1 Click the Target tool to select it. 

The cursor changes to the green I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Target annotation.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is annotated in green 
lower case text as the target region.

Target annotation inserted (green lower case)
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Modifying a Target
Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
Target annotation. For instructions on modifying Target annotations, see 
“Modifying an Annotation” on page 6-4.
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How to Specify Where the Probe Must Anneal

Introduction Use the Probe tool for specifying a particular region in the sequence 
where the probe must anneal.

The Probe tool is available only in a TaqMan® Probe and TaqMan MGB 
document and takes the place of the Target tool. The Probe tool is used 
in the same way as the Target tool. Figure 6-1 shows how the TaqMan 
Probe appears on the Sequence page after primers and probes are 
calculated.

Figure 6-1 TaqMan Probe document

Primers

Probe
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Adding a Probe
Annotation

To add a probe annotation.

Modifying a Probe
Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
Probe annotation. For instructions on modifying Probe annotations, see 
“Modifying an Annotation” on page 6-4.

Step Action

1 Click the Probe tool to select it.

The cursor changes to the green I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the target region annotation.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is annotated in green 
lower case text as the Probe region.
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How to Exclude a Sequence Region

Introduction Use the Exclude Region tool for specifying a particular sequence region 
that you want excluded from amplification by the PCR reaction.

Adding an Exclude
Annotation

To add an exclude annotation.

Step Action

1 Click the Exclude tool to select it.

The cursor changes to the red I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Exclude annotation.

3 Click and drag to highlight the desired data. 

When you release the mouse button, the highlighted sequence text 
is annotated as the excluded region using a strike-through red line.

Exclude annotation inserted (strike-through)
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Modifying an
Exclude

Annotation

You can use the Select tool to move, lengthen, or shorten any Exclude 
annotation. For instructions on modifying or removing Exclude 
annotations, see “Modifying an Annotation” on page 6-4.
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How to Select a Forward Primer Region

Introduction Use the Forward Primer tool for setting a particular sequence region as 
the forward primer. A primer specified using this tool does not need to 
meet the criteria specified in the Params page.

Note Only one Forward Primer annotation is allowed for each set of Primers 
allowed by the Primer Express document (except for Multiplex PCR and Nested 
PCR, which allow more than one set of primers). Creating a new Forward 
Primer annotation automatically deletes any existing one, as well as deletes any 
Forward Primer End annotations and incompatible Target annotations.

Adding a Forward
Primer Annotation

The following procedure describes how to add a Forward Primer 
annotation.

To add a Forward Primer Annotation:

Step Action

1 Click the forward primer tool to select it. 

The cursor changes to the blue I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Forward Primer annotation.
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Modifying a
Forward Primer

Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
Forward Primer annotation. For instructions on modifying or removing 
Forward Primer annotations, see “Modifying an Annotation” on 
page 6-4.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is annotated as the 
forward primer.

To add a Forward Primer Annotation: (continued)

Step Action

Forward Primer annotation inserted (blue)
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How to Set a Sequence Residue as the Forward Primer End

Introduction Use the Forward Primer End tool for setting a particular sequence 
residue as the 3´ end of the forward primer. When you make an 
annotation of this type, the Primer Express software calculates only 
those forward primers that end with the specified residue.

Note Only one Forward Primer End annotation is allowed in each Primer 
Express document. Creating a new Forward Primer End annotation 
automatically deletes any existing one, as well as deletes any Forward Primer 
annotations and incompatible Target annotations.

Adding a Forward
Primer End
Annotation

The following procedure describes how to add a forward primer end 
annotation.

To add a forward primer end annotation:

Step Action

1 Click the Forward Primer End tool to select it. 

The cursor changes to the blue I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Forward Primer End annotation.
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Modifying a
Forward Primer
End Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
Forward Primer End annotation. For instructions on modifying or 
removing Forward Primer End annotations, see “Modifying an 
Annotation” on page 6-4.

3 Click the mouse button to insert the Forward Primer End 
annotation.

To add a forward primer end annotation: (continued)

Step Action

Forward Primer End annotation inserted (blue)
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How to Set a Sequence Region as the Reverse Primer

Introduction Use the Reverse Primer tool for setting a particular sequence region as 
the reverse primer. A primer specified using this tool does not need to 
meet the criteria specified in the Params page.

Note Only one Reverse Primer annotation is allowed in each Primer Express 
document. Creating a new Reverse Primer annotation automatically deletes 
any existing one, as well as deletes any Reverse Primer End annotations and 
incompatible Target annotations.

Adding a Reverse
Primer Annotation

To add a reverse primer annotation.

Step Action

1 Click the Reverse Primer tool to select it.

The cursor changes to the blue I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Reverse Primer annotation.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is annotated as the 
Reverse Primer.

Reverse Primer annotation inserted (blue)
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Modifying a
Reverse Primer

Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
Reverse Primer annotation. For instructions on modifying or removing 
Reverse Primer annotations, see “Modifying an Annotation” on 
page 6-4.
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How to Select a Sequence Region as Reverse Primer End

Introduction Use the Reverse Primer End tool for setting a particular sequence 
residue as the 3´ end of the reverse primer. When you make an 
annotation of this type, the Primer Express software calculates only 
those reverse primers that end with the specified residue.

Note Only one Reverse Primer End annotation is allowed in each Primer 
Express document. Creating a new Reverse Primer End annotation 
automatically deletes any existing one, as well as deletes any Reverse Primer 
annotations and incompatible Target annotations.

Adding a Reverse
Primer End
Annotation

The following procedure describes how to add a reverse primer end 
annotation.

To add a reverse primer end annotation.

Step Action

1 Click the Reverse Primer End tool to select it. 

The cursor changes to the blue I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin the Reverse Primer End annotation.

3 Click the mouse button to insert the Reverse Primer End 
annotation.

Reverse Primer End annotation inserted (blue)
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Modifying a
Reverse Primer
End Annotation

You can use the Select tool to move, lengthen, shorten any existing 
Reverse Primer End annotation. For instructions on modifying or 
removing Reverse Primer End annotations, see “Modifying an 
Annotation” on page 6-4.
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How to Translate DNA to Amino Acid Sequence

Introduction Use the ORF (open reading frame) tool for translating a selected DNA 
region into its corresponding amino acid sequence using the three-letter 
amino acid abbreviations directly beneath the sequence data. This tool 
is useful as a mnemonic for protein coding sequences.

Adding a
Translation
Annotation

The following procedure describes how to add a translation annotation.

Note You can only make ORF annotations in multiples of three bases. If you 
make an ORF annotation that is not a multiple of three bases, the Primer 
Express software shortens the annotation to the correct length.

To add a translation annotation.

Step Action

1 Click the ORF tool to select it. 

The cursor changes to the open arrow cursor ( ).

2 Position the open arrow cursor over the sequence base where you 
wish to begin the annotation.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is annotated with 
amino acid translation abbreviations.

Translation annotation inserted (red)
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Modifying a
Translation
Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
translation annotation. For instructions on modifying translation 
annotations, see “Modifying an Annotation” on page 6-4.

4 Any sequence data that does not specify individual bases (A, C, G, 
or T) does not translate into amino acid abbreviations, but is 
annotated with dots beneath the sequence data.

To add a translation annotation. (continued)

Step Action

Translation annotation 
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How to Highlight Sections of Sequence Text

Introduction Use the Line tool for highlighting sections of sequence text. If you wish 
to mark a section of the sequence data with an annotation different from 
any of the other annotations available in the Primer Express software, 
use the line tool. Line annotations do not affect the calculation of 
primers.

Adding a Line
Annotation

To add a line annotation.

Step Action

1 Click the Line tool to select it. 

The cursor changes to the magenta I-beam cursor ( ).

2 Position the I-beam cursor over the sequence base where you wish 
to begin underlining.

3 Click and drag to highlight the desired data. When you release the 
mouse button, the highlighted sequence text is underlined.

Sequence text underlined (magenta)
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Modifying a Line
Annotation

You can use the Select tool to move, lengthen, or shorten any existing 
line annotation. For instructions on modifying or removing Line 
annotations, see “Modifying an Annotation” on page 6-4.
Using the Annotation Tools 6-23



How to Create a Junction Annotation

Introduction Use the Junction tool to create a junction annotation across two 
adjacent bases. This tool allows the user to mark exon junctions. When 
the Primer Express software calculates primers, at least one primer in 
each pair crosses at least one exon junction.

Primary Uses One of the primary uses of the Junction Tool is to mark the positions of 
the exon junctions. This creates primers that amplify only mRNA (or 
cDNA made from it), but not genomic DNA.

You can annotate sequence data on the Sequence page with any 
number of Junction annotations.

Creating a
Junction

Annotation

The following procedure describes how to create a junction annotation.

To create a junction annotation.

Step Action

1 Click the Junction tool to select it. 

The cursor changes to the junction cursor ( ).
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Modifying a
Junction

Annotation

You can use the Select tool to move a Junction annotation. For 
instructions on moving Junction annotations, see “Modifying an 
Annotation” on page 6-4.

Removing a
Junction

Annotation

You can use the Eraser tool to remove any existing junction 
annotations. For instructions on removing junction annotations, see 
“How to Delete Annotations” on page 6-5.

2 Position the junction cursor over the first sequence base in the 
junction, and click the mouse button to insert the Junction 
annotation.

To create a junction annotation. (continued)

Step Action

Junction annotation inserted (blue)
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How to Create Restriction Enzyme Site

Introduction Use the Site tool to create restriction enzyme or cloning site 
annotations. When you insert a site annotation, you can name the site 
with a label containing up to 15 characters.

Adding Site
Annotations

To add site annotations:

Step Action

1 Click the site tool to select it. 

The cursor changes to the site arrow cursor( ).

2 Position the site arrow cursor over the sequence base you wish to 
annotate, and click the mouse button to insert the site annotation.

3 Click the word Site once to select it, then type your annotation text.

Site annotation inserted (blue)
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Moving a Site
Annotation

To move a site annotation.

Removing Site
Annotations

The following procedure describes how to remove a site annotation.

Step Action

1 Click the Select tool on the tool palette.

2 Position the Select tool cursor over the site annotation arrow ( ).

3 When in the correct position, the I-beam cursor changes to the 
transparent open hand cursor ( ).

4 Click and hold the cursor. 

The piece of sequence data at the site currently annotated 
highlights with a small highlight box.

5 To move the annotation site, drag the highlight box in any direction.

To remove a site annotation:

Step Action

1 Click the Select tool on the tool palette.

2 Click the annotation text once to select it, then press the delete key 
to remove the annotation text.

3 Click anywhere in the sequence data to remove the annotation site 
from the sequence.
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Primer Express 
Software Menus 7

Introduction

In

In This Chapter The Primer Express® software incorporates a user interface that gives 
you an on-screen notebook to use for designing oligos. Although most 
of the functions of the Primer Express software are contained in the 
seven pages of the notebook, there are a number of important functions 
that you can perform only from a menu option or its keyboard shortcut. 
The following sections describe the options available in each Primer 
Express software menu.

Topics in this chapter include the following:

Topic See page

File Menu 7-2

Edit Menu 7-8

Options Menu 7-14

Windows Menu 7-17
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File Menu

About the File
Menu

The File menu contains menu options for creating, opening, closing, 
saving, importing, exporting and printing files.

New Command About the Command

This command displays a submenu that allows you to create a new 
Primer Express document for DNA PCR, RT PCR, Nested PCR, Allele 
Specific PCR, Multiplex PCR, TaqMan® Probe & Primer Design, Cycle 
Sequencing, Sequencing Primer, Batch Processing, Primer Test, 
TaqMan® MGB Probe & Primer Design, or TaqMan® MGB Probe Test. 

The Primer Express software supports up to 99 simultaneous 
documents, but keeping more than ten documents open at any one 
time can slow performance to an unacceptable level.
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How to Open a New Document

Open Command General Information

Use this command to open any document (Figure 7-1) currently saved 
in the Primer Express software Archive file. The saved documents are 
displayed in a Document Archive window that appears. 

Sorting the Headings

You can sort the headings by clicking one of the headings. The heading 
currently used to sort is underlined (default = Name).

Note Use the Import option to open sequence or other files located in your 
program file. For more information, see “Import Command” on page 7-6.

Figure 7-1 Document Archive Window

To open a new document.

Step Action

1 From the File menu, highlight New until the submenu appears to 
the right.

2 Still holding down the mouse button, move the cursor to the 
submenu, then down to the document type you wish to open.

3 Release the mouse button to open the new document.
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About the Buttons

The following table describes the buttons.

Open Results
Command

General Information

Use this command to display the Results Archive window (Figure 7-2). 
The window contains a listing of all the Primer Express software results 
saved using the Save Results button on the Results page. For more 
information about saving results, see “Saving Your Results” on 
page 5-52. The heading currently used to sort is underlined.

s

Figure 7-2 Results Archive window

Button Description

Open button Opens the selected (highlighted) document listed in 
the Document Archive.

Delete button Deletes the selected (highlighted) document from the 
Document Archive.

Help button Activates Primer Express Guide.

Underlined heading 
indicates results are 
sorted by User name
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About the Buttons

The following table describes the buttons.

How to Open the Document that Generated the Results Window

Click the Open Related Document button to open the document that 
generated the currently active Results window.

Note To access this feature, you must have saved the related document 
using the Save or Save As command.

Close Command Use this command to close the active Primer Express document. If you 
haven’t saved the changes to the document, a dialog box appears to 
allow you to save the changes. This menu option is equivalent to 
clicking the document’s close box.

Save/Save As
Command

You can save Primer Express documents (except Batch Processing 
and TaqMan MGB Probe Test) in the Primer Express software Archive 
file for future reference. When you select Save or Save As from the File 
menu, a dialog box similar to the one below appears.

The Primer Express software automatically assigns a name to any 
document you choose to save. You may change the name by 
highlighting the current name and typing the new name.

You cannot use the Save and Save As menu commands to create new  
files. Use the Export menu option.

Button Description

Open button Opens the selected (highlighted) document listed in 
the Results Archive.

Delete button Deletes the selected (highlighted) document from the 
Results Archive.
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Note You cannot save Batch Processing documents, but the individual 
documents within a Batch are automatically saved to the Primer Express 
software Archive file immediately after processing.

Import Command Use this command to open a Primer Express software-formatted file. 
This function is the complement to Export, and is useful when you want 
to transfer a Primer Express software file between computers using a 
disk or over a network.

Export Command Use this command to save a Primer Express document in the Primer 
Express software format on your computer’s hard disk. This function is 
the complement to Import, and is useful when you want to transfer a 
Primer Express software file between computers using a disk or over a 
network. If you have changed the sequence name on the Sequence 
page, this name is used in the Export navigation dialog box.

Printing Settings The following table lists settings for printing the sequence, primers, and 
map pages.

Printing settings:

To print the... Set...

Sequence 
page

Print Setup

� Reduce or Enlarge: 90%

� Orientation: Landscape mode

Document Setup

Resize the Primer Express document to 100 bp wide. This 
produces a printed page that holds up to 3600 bp.

Primers page The data on the DNA PCR Primers page (forward primer, 
reverse primer, and amplicon data) fits best on a standard 
8.5 x 11-inch paper.

Print Setup

� Reduce or Enlarge: 85%

� Orientation: Landscape mode

If you are printing a Primer Express document that has 
more heading on the Primers page (Nested PCR or 
Multiplex PCR), you have to experiment with reduction 
and page orientation.
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Quit Command Note You cannot save Batch Processing and Primer Test documents.

Use this command to exit from an application. If you quit after adding or 
modifying sequence data, you can save the document in the Primer 
Express software Archive.

Map page You have to experiment to determine the best layout for 
printing your Map page. If you are printing at 1X 
magnification, then set up your printer as follows.

Print Setup

� Reduce or Enlarge: 100%

� Orientation: Portrait mode

Printing settings: (continued)

To print the... Set...
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Edit Menu

About the Edit
Menu

The Edit menu contains menu options for editing and searching for 
sequence text. 

Copy Complement Use this command to write sequence text to the clipboard that is 
complementary to the highlighted text, as well as in the reverse 
direction. 

For example, if the highlighted text is AAAG, the Copy Complement 
option puts the text CTTT onto the clipboard. After you have used the 
Copy Complement menu option, you can paste the complementary text 
into a Primer Test document or use it in a Find Sequence command. 
For information, see “Primer Test Document” on page 4-67 or “Find 
Sequence” on page 7-9.

Clear All
Annotation

Use this command to simultaneously erase all annotations currently on 
the Sequence page.

To erase annotations individually, use the Eraser tool. For information 
about the Eraser tool, see “How to Delete Annotations” on page 6-5.
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Find Sequence General Information

Use this command to locate specific patterns or restriction enzyme sites 
on the Sequence page. The Find Sequence dialog box appears.

Fields

The following table describes the fields in the Find Sequence dialog 
box.

Field Description

Find the next 
occurence of the 
sequence

Enter the sequence data you wish to find. 

If you select an entry from the Sites pop-up menu, 
both the sequence data and the restriction enzyme 
label are entered in the two data fields.

Add button Use to make custom additions to the Sites pop-up 
menu. 

Type label and sequence data into the two data fields, 
then click the Add button to add the label to the 
bottom of the Sites pop-up menu.

Sites
pop-up
menu
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How to Find a Sequence

Starting At pop-up 
menu

Select one of two options from this pop-up menu.

Site pop-up menu This pop-up menu contains a number of common 
restriction site labels and their corresponding 
sequences.

Find and 
Label...checkbox

Select this checkbox to annotate all occurrences of 
the sequence text with the appropriate site 
annotation. For more information, see “How to Create 
Restriction Enzyme Site” on page 6-26.

Delete All 
Sites...checkbox

Select this checkbox to delete any existing site 
annotations that match the specified sequence data.

To find a sequence.

Step Action

1 Enter a sequence in the upper data field or select a site label from 
the Sites pop-up menu.

If you select one of the common restriction site labels from the 
pop-up menu, the sequence that corresponds to that label appears 
in the upper entry field and the site label appears in the lower entry 
field.

2 If you wish the Primer Express software to label the sequence 
differently from the default, enter the label in the lower entry field. 

If you leave the label field empty, the Primer Express software 
underlines any sequences found rather than label the sequence 
with a site annotation.

Field Description

Choose To search from the...

Current cursor position 
(default)

current cursor position 
to the end of the 
sequence data. 

If any sequence text is 
highlighted, then the 
search begins at the 
end of the highlighted 
area.

Beginning of the 
sequence

beginning of the 
sequence data to the 
end
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Find Target
Command

Use this command to simultaneously find and annotate occurrences of 
repeated patterns on the Sequence page. The Find Target dialog box 
appears.

For example, if you use the default data in the Find Target dialog box, 
the Primer Express software searches for the sequence 
CACACACACACACACA. Any sequence data that matches the 
specified repeated sequence data pattern is annotated as a target 
region. For more information, see “How to Specify a Sequence Region” 
on page 6-6.

Note After you have used the Find Sequence or Find Target command, the 
Undo command does not function.

Find and Exclude
Command

Use this command to find and exclude repeat sequences, such as ALU, 
or vector sequences. The Find and Exclude commands find 
subsequences within the sequence text and marks those 
subsequences with the Exclude annotation.

The Find and Exclude dialog box provides several data fields to control 
the threshold at which similar sequence data is excluded, along with 
buttons for adding and removing sequence files.

3 Press OK to find and annotate the sequence.

Note The Undo option does not function after the Find 
Sequence or Find Target option has been used.

To find a sequence. (continued)

Step Action
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The following table describes the fields in the Find and Exclude dialog 
box.

Show/Hide Page
Breaks Command

Use this command to toggle the display of page breaks in the 
Sequence, Primers, and Map pages. You can use this option if you print 
one of these pages. Page breaks are shown as zig-zag lines and can 
occur horizontally or vertically if the available data won’t fit onto one 
page, as determined by the Page Setup.

Field Description

% Similarity Any data in the imported sequence, that has similarity 
greater than or equal to the specified value (default = 
75%), is found and marked with the Exclude 
annotation.

For information about the Exclude annotation, see 
“How to Exclude a Sequence Region” on page 6-10.

Over X Residues Find and Exclude examines a window of the specified 
size (default = 20) to determine the % similarity.

Add 
Sequence/Remove 
Sequence buttons

Use these buttons to add or remove sequences from 
the scrolling pane.
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Preferences
Command

Use the Primer Express Preferences dialog box (Figure 7-3) to set the 
default parameter values for each document type, as well as the default 
quantities of stocks specified on the Recipe page. 

To select a document type or stock solutions, select from the pop-up 
menu at the top of the dialog box.

IMPORTANT The parameters contained in the Preferences dialog box do not 
affect already open documents, including Batch Processing. Select the Params 
page of each open document to change parameters on already open 
documents.

Users should set preferences based on the needs of the PCR 
application. The factory default preference values are place holders 
until modified by the user.

Figure 7-3 Primer Express Preferences dialog box

=

Define Penalty
Score

The Primer Express software calculates the Penalty Score using the 
formula shown in the Penalty Definition dialog box. For more 
information, see Appendix B, “Calculating Penalty Score.”

Pop-up menu 
for selecting 
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Options Menu

About the Menu The Options menu contains a number of display and other functions.

Turn AutoFind
ON/OFF

When to Turn this Command ON

Use this command to automatically calculate primers immediately after 
a sequence is

� Imported into a document, or

� An annotation is made to the sequence data on the Sequence 
page. 

For many applications, AutoFind is a useful and time-saving feature to 
have turned on.

When to Turn this Command OFF

Leave AutoFind OFF if you

� Are making many annotations to the sequence data and don’t want 
the Primer Express software to calculate primers between the 
making of each annotation, or you

� Want to make a number of parameter changes.

AutoFind is turned OFF by default. When you are through importing 
sequences, then select Find Primers Now to calculate the primers 
based on all the imported sequences.

Find Primers Now If the AutoFind feature is selected (ON) and you have made a change 
to the sequence text, annotations, or parameters, you must newly 
select one of the following pages to direct the Primer Express software 
to calculate primers: 

� Sequence page
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� Primers page

� Map page

Note To calculate primers, one of the pages above must be active.

The Find Primers Now command does not function when AutoFind is 
selected.

Note This menu option appears as Find Primers/Probes Now if you are 
working in a TaqMan Probe document.

If AutoFind not selected (OFF), you can direct the Primer Express 
software to calculate primers by selecting the Find Primers Now 
command.

Show/Hide
Annotation Tools

Use this command to toggle the display of the Annotation Tools Palette. 
For more information, see Chapter 6, “Using the Annotation Tools.”

Show/Hide Primer
Data

Use this command to toggle the display of the Primer Data Window. For 
more information, see “Features” on page 5-5.

Show/Hide Interim
Results

Use this command to toggle the display of the Interim Results window. 
This window contains the results of a number of different tests the 
Primer Express software runs when calculating primers. For a complete 
description of each test, see Appendix A, “Interim Results Window.”

Primer pair tests

Primer tests
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Show/Hide Primer
Secondary
Structure

Use this command to toggle the display of the Secondary Structure 
window, which shows the maximal possible secondary structure and 
primer dimer structure that each primer of the selected primer set may 
form. The upper lines indicate the maximal consecutive complementary 
bases and the lower lines indicate the maximal nonconsecutive 
complementary bases.

Show/Hide Status
Bar

Use this command to toggle the display of the status bar, located at the 
bottom of the document. The status bar informs you about the status of 
a primer calculation, for example, how many primers were found or 
what you need to do to find primers.

Maximal 
consecutive 
complementary 

Maximal 
consecutive 
complementary 

Status bar
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Copy Page To
Window

Use this command to copy the page currently being viewed and open a 
new window containing the copied page.

The copy of the page acts exactly like the original. If you make a 
change in the copy, it is the same as making a change in the original 
page. If you are using a larger monitor, you can have several copies of 
windows open on the desktop, so that when you make a parameter 
change, you can see the resulting change in the primers without having 
to click on another page.

Windows Menu

About the
Windows Menu

The Windows menu contains the names of all the currently open Primer 
Express documents. The currently active document is indicated by a 
check mark next to the document name. Each document is named by 
document type and sequential number. 

Making a
Document Active

To make a document active, you can

� Select the document name from the Windows menu, or 

� Click the document window.

Currently active document (check mark)
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A
Interim Results 
Window A

Introduction

In This Appendix Topics in this appendix include the following:

How to View the Window

Viewing the
Window

The Interim Results window, when selected, displays whenever the 
Sequence page, Params page, Primers page, or Map page is active. 
You can reposition the Interim Results window anywhere on the 
desktop by dragging to a new location. 

To view the Interim Results window, select Show Interim Results from 
the Options menu.

Topic See page

How to View the Window A-1

About the Tests A-2
Interim Results Window A-1



About the Tests

Introduction The Interim Results window contains a listing of all the tests the Primer 
Express® software uses to eliminate primers from consideration. Each 
test uses a formula that considers one or more parameters in order to 
eliminate primers. If a particular test causes a significant elimination of 
primers, you should consider changing the associated parameters if 
you want the Primer Express software to find more primers.

Ambig Test The Ambig (Ambiguity) Test counts the number of ambiguous residues 
in each primer (residues that are not A, C, G or T). If the number of 
ambiguous residues exceeds the Max Num Ambigs parameter value, 
the primer is rejected.

To increase the number of primer pairs found, increase the Max Num 
Ambigs parameter value.

Clamp Test The Clamp Test determines whether the number of G or C residues at 
the primer’s 3´ end is greater than or equal to the GC Clamp parameter 
value.

To increase the number of primer pairs found, decrease the GC Clamp 
parameter value. For most DNA sequences, a GC Clamp setting of 
greater than two causes no primer pairs to be found.

GC Test The GC Test calculates the GC content of the primer. If the GC content 
is greater than or equal to the Min %GC parameter value and less than 
or equal to the Max %GC value, then the primer passes this test. 
Because of the variable GC content of DNA sequences, you may need 
to change this parameter often so that the Primer Express software can 
find primer pairs.

To increase the number of primer pairs found, increase the Max %GC 
parameter value and/or decrease the Min %GC parameter value.
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Tm Test The Tm Test determines the Tm of the primer using the nearest neighbor 
algorithm. For more information about this algorithm, see Appendix G, 
“Formula Used in Primer Express.”

If the calculated primer Tm is greater than or equal to the Min Tm value, 
and less than or equal to the Max Tm value, the primer passes this test. 
Because of the variable GC content of DNA sequences and the 
dependence of calculated Tm on GC content, you may need to change 
the Min/Max %GC parameters often so that the Primer Express 
software can find primer pairs. In addition, because primer length 
affects primer Tm, you may need to change the primer length 
parameters to obtain the desired Tm.

To increase the number of primer pairs found, increase the Max Tm 
parameter value and/or decrease the Min Tm parameter value.

Repeat Test The Repeat Test is customized in the TaqMan® Primer and Probe 
document to reflect a unique sensitivity of these assays to repeat G 
sequences. For this document, the repeat exclusion is only applied to G 
sequence. All other repeats are tolerated in the selection criteria. 
Nucleotide repeats other than G must be assessed manually in this 
document.

Secondary Struc
Test

The Secondary Struc (Secondary Structure) Test checks for significant 
internal secondary structure. It does this by attempting to form all 
possible hairpins with the sequence and determining, for each possible 
hairpin, both the maximum number of consecutive residues that could 
base-pair in such a structure, and the total number of base pairs 
formed. The highest scores for each of these parameters over all the 
structures is retained and tested against the Max Consec Base Pair and 
Max Total Base Pair parameter values. If the test score is less than or 
equal to both of these parameters, the primer passes this test.

To increase the number of primer pairs found, increase the Max Consec 
Base Pair and/or Max Total Base Pair parameter values.
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Primer Site
Unique Test

The Primer Site Unique (Primer Site Uniqueness) Test determines if the 
primer has significant sequence similarity to any other region of the 
DNA sequence. If such sequence similarity exists, mispriming could 
result.

The three different measures of similarity examined are: 

� Maximum number of consecutive residues that match.

� Percentage match over the entire subsequence.

� Number of consecutive residues matching at the 3' end. 

The maximum acceptable values for these criteria are specified in 
Primer Site Uniqueness Requirements. If the sequence being examined 
by the Primer Express software is the entire template sequence (that is, 
if the PCR is being performed on cloned DNA, the entire sequence of 
which has been entered in the program) this test should prevent 
mispriming.

To increase the number of primer pairs found, increase any or all of the 
following parameter values:

� Max Consec Match

� Max %Match

� Max 3' Consec Match

Amplicon Length
Test

The Amplicon Length calculates the length of the amplified sequence 
generated by the primer pair. If this length is greater than or equal to the 
Amplicon Min Length and less than or equal to the Amplicon Max 
Length, the primer pair passes this test.

To increase the number of primer pairs found, increase the Amplicon 
Max Length parameter value and/or decrease the Amplicon Min Length 
parameter value.
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Avoid Excludes
Test

The Avoid Excludes Test checks each primer pair to determine if any 
excluded region is amplified. If the amplified region avoids all excluded 
regions, the primer pair passes this test. You can import excluded 
regions as part of a sequence file or you can annotate them. For more 
information, see “How to Exclude a Sequence Region” on page 6-10.

To increase the number of primer pairs found, remove or shorten any 
Exclude Region annotations.

Tm Match Test The Tm Match Test calculates the difference between the Tm values for 
the forward and reverse primers. If this difference is less than or equal 
to the Maximal Tm Difference value, the primer pair passes this test.

To increase the number of primer pairs found, increase the Maximal Tm 
Difference parameter values.

Amplicon Tm Test The Amplicon Tm Test calculates the Tm of the amplified sequence 
based on GC content and length. If the calculated Tm is greater than or 
equal to the Amplicon Min Tm value, and less than or equal to the 
Amplicon Max Tm value, the primer pair passes this test. 

To increase the number of primer pairs found, increase the Amplicon 
Max Tm parameter value and/or decrease the Amplicon Min Tm 
parameter value.

Target Test The Target Test checks each primer pair to determine if the Target 
Region is amplified. If the Target Region is amplified, the primer pair 
passes this test. Target Region annotations are made by the user. For 
more information, see “How to Specify a Sequence Region” on 
page 6-6.

To increase the number of primer pairs found, remove or shorten any 
Target Region annotations.
Interim Results Window A-5





Calculating Penalty 
Score B

About Penalty Score

Assigning Penalty
Score

When calculating primer pairs, the Primer Express® software assigns 
each primer/amplicon set a Penalty Score that indicates its relative 
value. A lower Penalty Score is better and indicates a primer/amplicon 
set that satisfies a greater percentage of the parameters contained in 
the Parameters page. Penalty score is not absolute, that is, the 
numbers assigned do not directly correlate to any physical 
measurement.

Penalty scores are calculated during amplicon assembly, and are used 
to dynamically select the best 200 amplicons from among all possible 
amplicons.Penalty Score is displayed on the Primers page in the 
column at the far right (you must scroll to the right to view the penalty 
score).

How the Penalty
Score is Calculated

The Primer Express software calculates the Penalty Score using the 
formula shown in the Penalty Definition dialog box (Figure B-1), which 
contains values the user can modify.
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Displaying Penalty
Score Dialog Box

To display the Penalty Score dialog box, choose Define Penalty Score 
from the Edit menu.

Figure B-1 Penalty Definition dialog box

Weightings of the
Values

In the default Penalty Definition values, Difference between Primer Tms 
is weighted quite heavily, while two of the criteria are not weighted at all 
(Number Ambiguous Residues and Max Length � Amplicon Length). 
You can change the weighting of the criteria by modifying the values 
contained in the Penalty Definition dialog box.

Features The following tables lists the features of the Penalty Score dialog box.

Document type 
pop-up menu

Feature Description
Document Type 
pop-up Menu

Allows you to select the document type about which 
you wish to set the Penalty formula.

|Tm � Opt Tm| Considers the absolute value of the difference 
between the primer Tm and optimal Tm parameter.

|Primer Length � 
Opt Primer Length|

Considers the absolute value of the difference 
between the primer length and optimal primer length 
parameter.
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Number 
Ambiguous 
Residues

Considers the number of ambiguous residues found 
in each primer.

Difference 
Between Primer 
Tms

Considers the absolute value of the difference 
between the two primer Tms.

Amplicon Length � 
Min Amplicon 
Length

Considers the value of the difference between the 
amplicon length and minimal amplicon length 
parameter.

Max Amplicon 
Length � Amplicon 
Length

Considers the value of the difference between the 
maximal amplicon length parameter and amplicon 
length.

If Only One Primer 
Discriminates

Adds 10 to the Penalty score if only one primer in an 
Allele Specific document discriminates between 
included and excluded sequences.

Τ!|Tm � Opt Tm| Considers the absolute value of the difference 
between the primer Tm and optimal primer Tm 
parameter for each primer pair in a Multiplex PCR 
document.

Τ!}Primer Length � 
Opt Primer Length|

Considers the absolute value of the difference 
between the primer length and optimal primer length 
parameter for each primer in a Multiplex PCR 
document.

Τ (Number 
Ambiguous 
Residues)

Considers the sum of the number of ambiguous 
residues found in all primers in a Multiplex PCR 
document.

Max Difference 
Between Primer 
Tms

Considers the largest value of the difference between 
any two primer Tms in a Multiplex PCR document.

Τ Max (0, X � 
Amplicon Size 
Spacing)

Penalizes too small a spacing between amplicons in a 
Multiplex PCR document. 

The spacing between each pair of adjacent amplicons 
in a Multiplex PCR document is measured. This 
number is subtracted from the user-definable 
amplicon spacing parameter �X� (default = 20). 

If the result is a positive number, then the number is 
used in the Penalty score calculation.

Distance Between 
Primer and 
TaqMan® Probe

Considers the distance between forward primer and 
the TaqMan probe in a TaqMan Probe document.

Feature Description
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Start � Min 
Distance From End

Penalizes primers that do not comply with the Min 
distance from end specified in the Parameters page 
of the Cycle Sequencing or Sequencing Primer 
document.

Max Distance From 
End � Start

Penalizes primers that are farther away from the 
sequence end in a Cycle Sequencing or Sequencing 
Primer document.

Feature Description
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File Types SupportedC

Introduction

In This Appendix The Primer Express® software is a member of the growing suite of 
Applied Biosystems software applications designed for DNA analysis. 
The software recognizes a number of different file formats, including 
files from Applied Biosystems software and instruments.

Topics in this appendix include the following:

Topic See page
Imported Sequence Files C-2
Exported Files C-3
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Imported Sequence Files

Table of Imported
File Types

You can import the following file types into a DNA PCR, RT PCR, 
Nested PCR, Multiplex PCR, TaqMan® Probe, Cycle Sequencing, 
Sequencing Primer, or Batch Processing document.

Imported
Alignment Files

You can import the following file types into an Allele Specific document.

File type Description
373/377/310 
Sequence Files

Sequence files created by ABI PRISM® Automated 
Genetic Analyzers and DNA Sequencers.

Factura� ABI PRISM batch processing software that cleans up 
and annotates sample files from DNA analyzers and 
sequencers.

GenBank To import the sequence text from these applications, 
save the file as an unformatted text file.

EMBL To import the sequence text from these applications, 
save the file as an unformatted text file.

GCG To import the sequence text from these applications, 
save the file as an unformatted text file.

FASTA To import the sequence text from these applications, 
save the file as an unformatted text file.

ASCII Text The Primer Express software recognizes only 
unformatted ASCII text. You cannot import formatted 
files from word processing or page layout programs 
such as Microsoft Word or PageMaker. 

To import the sequence text from these applications, 
save the file as an unformatted text file.

File type Description
Sequence 
Navigator®

ABI PRISM software for producing multiple alignments.
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Exported Files

Table of Exports
Files

The following table lists the files that you can export.

File Description
Primer Express File A Primer Express file is a complete Primer Express 

document, saved on your hard disk, that you can 
transfer between users or computers.

To create a Primer Express software file:
a. Import a sequence or alignment, then calculate 

primers.
b. Select Export from the File menu.
c. Navigate to the location you wish to save the 

Primer Express document.
d. Click Export to save the document.

Primer Data File A Primer Data file is a text file that contains 
tab-delimited text (including headings) from the 
Primers page of a Primer Express document. A 
Primer Data file is saved on your hard drive so you 
can import the data into a word processor, 
spreadsheet, or other application, or you can print the 
data file.

To create a Primer Data file:
a. Import a sequence or alignment, then calculate 

primers.
b. Change to the Primers page.
c. Click the Save List button.
d. Navigate to the location you wish to save the 

Primer Data file.
e. Click Save to save the data.
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PCR Enzymes and 
Primer Express D

Designating the PCR Enzyme

Introduction The Reaction Conditions (Rxn Cond) page features a pop-up menu for 
designating the PCR enzyme used in the reaction. This pop-up menu 
contains four enzyme options:

� AmpliTaq® DNA Polymerase

� AmpliTaq® Stoffel Fragment

� rTth DNA Polymerase

Each Enzyme For
PCR Application

Each PCR enzyme has special salt and MgCl2 (magnesium chloride) 
requirements and is used for a different type of PCR application. The 
salt and MgCl2 concentrations determine the quality of primers selected 
by the Primer Express® software (quality, in this case, is expressed 
primarily in terms of Tm). 
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Reaction
Conditions Page

Diagram

The following is an example of the Reaction Conditions (Rxn Cond) 
page.

Pop-Up Menu
Items

The following table lists the composition and uses of each enzyme 
contained in the pop-up menu.

Enzyme pop-up menu

Menu item Description

AmpliTaq® DNA 
Polymerase

Brand name for the generic Taq (Thermus aquaticus) 
DNA polymerase, which is a standard polymerase 
chosen for most general PCR applications.

Taq DNA polymerase is the ideal enzyme for most 
PCR applications because its optimal activity is in the 
same temperature range at which stringent primer 
annealing takes place (55–75 °C).
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AmpliTaq Stoffel 
Fragment

Modified AmpliTaq DNA polymerase that is more

� Thermostable than standard Taq DNA 
polymerase.

� Exhibits optimal activity over a broader range of 
magnesium ion concentrations (2–10 mM).

� Lacks any intrinsic 5´-to-3´ exonuclease activity. 

These properties make Stoffel the enzyme of choice 
for GC-rich templates, as well as templates known to 
contain complex secondary structure.

Stoffel has been known to provide superior 
performance in sequence specific amplification 
(allele-specific PCR) of rare genetic variants. 

Because of its unique property of exhibiting optimal 
activity over a broad range of magnesium ion 
concentrations, Stoffel is highly recommended for 

� Rapidly optimizing PCR reactions and is useful 
when performing Multiplex PCR. 

� Carrying out Arbitrarily Primed PCR (AP-PCR) or 
Random Amplified Polymorphic DNAs (RAPDs).

rTth DNA 
Polymerase

Thermostable polymerase that is able to reverse 
transcribe RNA to cDNA quickly and efficiently in the 
presence of MnCl2 (manganese chloride) at elevated 
temperatures. This enzyme also acts as a DNA 
polymerase for subsequent PCR amplification in the 
presence of MgCl2 (magnesium chloride) after 
chelation of the manganese ion with Ethyleneglycol 
Bis(aminoethylether) Tetraacetic Acid (EGTA). 

Consequently, you can use rTth as both a 
thermostable reverse transcriptase and as a 
thermostable DNA polymerase in successive 
reactions in the same tube.

Menu item Description
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Theory of OperationsE
Introduction

In This Appendix This section describes the internal processes that the Primer Express® 
software uses to calculate satisfactory PCR primer pairs.

For complete descriptions of the:

� Individual tests shown in the Interim Results window, see 
Appendix A, “Interim Results Window.”

� Effects of individual annotations on finding primers, see Chapter 6, 
“Using the Annotation Tools.”

Topics in this appendix include the following:

Topic See page

How the Primer Express Software Finds Primers E-2

Stages for Calculating Individual Primers E-3

Stages for Calculating Primer Pairs E-6
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How the Primer Express Software Finds Primers

Overview The Primer Express software finds PCR primer pairs by screening 
potential primer pairs against default or user supplied criteria, then 
returning only those pairs that meet the criteria. 

A series of tests to find acceptable primer pairs are performed first on 
all candidate primer sequences, then further on those forward and 
reverse primers that pass the initial tests. Consider the primer selection 
process as a series of filters and only those candidate primer 
sequences that pass the first test are subjected to the second test, only 
those that pass the second are subjected to the third, and so on.

Primer Pair
Searching

The primer pair search effort takes place in three stages.

Order of Tests The number of sequences subjected to a later test is always less than 
or equal to the number subjected to an earlier test. Therefore, the tests 
have been ordered so that the least computationally intensive are 
performed early in the series, and the most computationally intensive 
are performed late in the series. The results of these tests (that is, the 
number of primers that pass each test) are shown in the Interim Results 
window, see Appendix A, “Interim Results Window.”

Stage Action

1 Acceptable forward primers are found.

2 Acceptable reverse primers are found.

3 Forward and reverse primers are tested in all possible 
combinations to find acceptable primer pairs.
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Stages for Calculating Individual Primers

Calculating
Individual Primers

The Primer Express software uses the following process to find 
acceptable individual forward and reverse primers. The associated 
parameters on the Parameters page are listed for each step in the 
process.

Table E-1 Stages for calculating individual primers.

Stage Description

1 Determine the primer length.

2 Count the number of ambiguous residues (those that are not A, 
C, G or T). 

3 Determine whether the primer has the required number of G or 
C residues at its 3' end.

IF the primer... THEN...

is too long or too short reject the primer

is acceptable test further (Primer Length 
Requirements: Min and Max 
Length)

IF the primer... THEN...

count exceeds the 
specification

reject the primer

count meets the 
specification

test further (Primer 
Composition Requirements: 
Max Num Ambigs)

IF the primer... THEN...

does not quality reject the primer

qualifies test further (Primer GC 
Content Requirements: 3' 
GC Clamp)
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1 Determine the GC content of the candidate primer.

2 Determine the Tm of the primer using the nearest neighbor 
algorithm.

3 Determine the longest run of repeated G bases in the primer. 

4 Calculate all possible hairpins within the primer. 

For each possible hairpin, determine both the maximum 
number of consecutive residues that could base-pair in such a 
structure, and the total number of base pairs formed.

Table E-1 Stages for calculating individual primers. (continued)

Stage Description

IF the primer... THEN...

GC content is too high or too 
low

reject the primer

GC content is acceptable test further (Primer GC 
Content Requirements: 
Min/Max %GC)

IF the primer... THEN...

Tm is too high or too low reject the primer

Tm is acceptable test further (Primer Tm 
Requirements: Min/Max Tm)

IF the primer... THEN...

exceeds the number of 
repeated bases exceeds the 
specified maximum

reject the primer

the number of repeated 
bases meets the 
specifications

test further (Primer 
Composition Requirements: 
Max G Repeat)

IF the hairpin... THEN...

exceeds the specified 
parameters

reject the primer

meets the specified 
parameters

test further (Primer 
Secondary Structure 
Requirements)
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5 Determine if the candidate primer has significant sequence 
similarity to any other region of the sequence.

Table E-1 Stages for calculating individual primers. (continued)

Stage Description

IF the primer... THEN...

exceeds any one of the 
similarity parameters

reject the primer

meets the similarity 
parameters

the primer is acceptable 
(Primer Site Uniqueness 
Requirements).
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Stages for Calculating Primer Pairs

Calculating
Primer Pairs

The Primer Express software forms candidate primer pairs by matching 
each calculated forward primer with each reverse primer, then tests 
each candidate primer pair using the following steps to determine 
ultimate acceptability.

For information on calculating primer pairs, see Appendix B, 
“Calculating Penalty Score.”

Table E-2 Stages for calculating primer pairs.

Stage Description

1 Calculate the length of the amplified sequence generated by 
the primer pair. 

2 Calculate the difference between the Tm values of the forward 
and reverse primers in the pair. 

3 Calculate the Tm of the amplified sequence, based on GC 
content and length. 

IF the... THEN...

amplified sequence is too 
long or too short

reject the primer

amplified sequence is 
acceptable

test further (Amplicon 
Requirements: Min/Max 
Length)

IF the... THEN...

difference exceeds the 
parameter value

reject the primer

parameter value is met test further (Primer Tm 
Requirements: Maximal Tm 
difference)

IF the... THEN...

calculated Tm is too high or 
too low

reject the primer

calculated Tm meets 
specification

test further (Amplicon 
Requirements: Min/Max Tm)
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4 Calculate all possible primer-dimer formation between the two 
primers.

5 Up to 200 primer pairs are passed to the user. 

If 200 pairs are passed, then they are the 200 pairs with the 
lowest penalty scores of all possible primer pairs (see 
Appendix B, “Calculating Penalty Score.”)

Table E-2 Stages for calculating primer pairs. (continued)

Stage Description

IF... THEN...

any 3´ sequence data on 
one primer matches any 
sequence data on the other 
primer

reject the primer

there are no 3´ sequence 
data on one primer that 
matches any sequence data 
on the other primer

the primer pair is acceptable
Theory of Operations E-7





IUPAC Codes F

Table of IUPAC Codes

IUPAC Codes The following table shows the meanings of the IUPAC characters you 
may encounter or use when working with a sequence on the Sequence 
page of a Primer Express® software. Several invalid characters are 
listed at the end of the table below.

Note You cannot type modified bases (for example, methylated C) into the 
Sequence page.

Code Meaning Code Meaning
A adenine B all except A
C cytosine D all except C
G guanine H all except G
T thymine V all except T
S strong (G or C) N A or C or G or T
W weak base pair 

(A or T)
I inosine (invalid)a

a. Inosine is considered by the Primer Express software an invalid base because its effect 
on Tm calculations is not completely known. You are not allowed to enter an �I� in the 
Sequence page. In addition, when the Primer Express software imports a DNA 
sequence file, it deletes all instances of Inosine.

M methyl (A or C) X,* (asterisk) invalid
K ketone (G or T)
R purine (A or G)
Y pyrimidine (C or T)
IUPAC Codes F-1





Formula Used in 
Primer Express G

Nearest Neighbor Algorithm for Tm Calculations

Algorithm Tm, expressed in °C, is calculated as follows using the nearest-neighbor 
algorithm developed by Breslauer et al. (1986).

where ΕH and ΕS are the enthalpy and entropy for helix formation, 
respectively, R is the molar gas constant (1.987 cal�K-1�mol-1), CT is the 
total strand (primer) concentration, and X is the salt concentration.

Tm =
ΕH°

� 273.15 + 16.6 log([X])
ΕS° + (R x ln (CT))
Formula Used in Primer Express G-1
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Software License I

PE Corporation (NY) Software License and Limited Product 
Warranty

Warranty
Statement

PURCHASER, CAREFULLY READ THE FOLLOWING TERMS AND 
CONDITIONS (THE �AGREEMENT�), WHICH APPLY TO THE 
SOFTWARE ENCLOSED (THE �SOFTWARE�). YOUR OPENING OF 
THIS PACKAGE INDICATES YOUR ACCEPTANCE OF THESE 
TERMS AND CONDITIONS. IF YOU DO NOT ACCEPT THEM, 
PROMPTLY RETURN THE COMPLETE PACKAGE TO APPLIED 
BIOSYSTEMS, 850 LINCOLN CENTRE DRIVE, FOSTER CITY, CA 
94404 AND YOUR PAYMENT WILL BE RETURNED. THE LAW 
PROVIDES FOR CIVIL AND CRIMINAL PENALTIES FOR ANYONE 
WHO VIOLATES THE LAWS OF COPYRIGHT.

Copyright The SOFTWARE, including its structure, organization, code, user 
interface, and associated documentation, is a proprietary product of PE 
Corporation (NY), and is protected by international laws of copyright. 
Title to the SOFTWARE, and to any and all portion(s) of the 
SOFTWARE, shall at all times remain with PE Corporation (NY), which 
grants to you the limited rights contained in this Agreement.

License 1. You may install and use each original copy of the SOFTWARE on a 
separate single computer (or on a single network, if your software is 
designated and licensed as a network version). You may transfer the 
SOFTWARE to another single computer (or network, if a network 
version), so long as you first delete the SOFTWARE from the previous 
computer or network. You shall not have operational SOFTWARE on 
more than one computer (or more than one network, if a network 
version) per original copy of the SOFTWARE at any time.

2. You may make one copy of the SOFTWARE for backup purposes 
provided that you reproduce all copyright and other proprietary notices 
Software License I-1



that are on the original copy of the SOFTWARE. You may replace the 
SOFTWARE on any single computer (or any single network, if 
applicable) with the backup copy if the need arises, but you shall not 
have operational SOFTWARE on more than one computer or network 
per original copy of the SOFTWARE at any time. PE Corporation (NY) 
shall own the title to the backup copy.

3. Registration codes for multiple users are available as follows:
Access to the number of copies of SOFTWARE is provided by a 
registration code. For example, if you have a registration code that 
enables you to use three copies of SOFTWARE simultaneously, you 
cannot install the SOFTWARE in more than three separate computers.

4. You agree not to transfer the SOFTWARE license to another party. 
Any such transfer terminates your license.

Restrictions 1. You agree not copy, transfer, rent, modify, use, or merge the 
SOFTWARE, or the associated documentation, in whole or in part, 
except as expressly permitted in this Agreement.

2. You agree not to reverse assemble, decompile, or otherwise reverse 
engineer the SOFTWARE.

Limited Warranty For a period of 90 days after purchase of the SOFTWARE, 
PE Corporation (NY) warrants that the SOFTWARE will function 
substantially as described in the documentation supplied by 
PE Corporation (NY) with the SOFTWARE. If you discover an error 
which causes substantial deviation from that documentation, send a 
written notification to PE Corporation (NY). Upon receiving such 
notification, if PE Corporation (NY) is able to reproduce that error at its 
facility, then PE Corporation (NY) will do one of the following at its sole 
option: (i) correct the error in a subsequent release of the SOFTWARE, 
which shall be supplied to you free of charge, or (ii) accept a return of 
the SOFTWARE from you, and refund the purchase price received for 
the SOFTWARE. PE Corporation (NY) does not warrant that the 
SOFTWARE will meet your requirements, will be error-free, or will 
conform exactly to the documentation. Any sample or model used in 
connection with this Agreement is for illustrative purposes only, is not 
part of the basis of the bargain, and is not to be construed as a warranty 
that the SOFTWARE will conform to the sample or model.
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Limitation Of
Liability

EXCEPT AS SPECIFICALLY STATED IN THIS AGREEMENT, THE 
SOFTWARE IS PROVIDED AND LICENSED “AS IS”. THE ABOVE 
WARRANTY IS GIVEN IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING THOSE OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
NOTWITHSTANDING ANY FAILURE OF THE CENTRAL PURPOSE 
OF ANY LIMITED REMEDY, PE CORPORATION (NY)’S LIABILITY 
FOR BREACH OF WARRANTY SHALL BE LIMITED TO A REFUND 
OF THE PURCHASE PRICE FOR SUCH PRODUCT. IN NO EVENT 
WILL PE CORPORATION (NY) BE LIABLE FOR ANY DAMAGES, 
INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN 
IF PE CORPORATION (NY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

Term You may terminate this Agreement by destroying all copies of the 
SOFTWARE and documentation. PE Corporation (NY) may terminate 
this Agreement if you fail to comply with all of its terms, in which case 
you agree to return to PE Corporation (NY) all copies of the 
SOFTWARE and associated documentation.

Miscellaneous 1. Failure to enforce any of the terms and conditions of this Agreement 
by either party shall not be deemed a waiver of any rights and privileges 
under this Agreement.

2. In case any one or more of the provisions of this Agreement for any 
reason shall be held to be invalid, illegal, or unenforceable in any 
respect, such invalidity, illegality, or unenforceability shall not affect any 
other provisions of this Agreement, and this Agreement shall be 
construed as if such invalid, illegal, or unenforceable provisions had 
never been contained herein.

3. This Agreement shall be construed and governed by the laws of the 
State of California.

4. This Agreement and the PE Corporation (NY) Sales Quotation 
constitute the entire agreement between PE Corporation (NY) and you 
concerning the SOFTWARE.
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Glossary

5´ Tail A short sequence added to the 5´ end of a primer. The addition of a 5´ end tail provides an 

increased number of sequences that can be used either as universal priming sites for sequencing or 
as restriction enzyme sites for cloning. When a 5´ tail is entered, the Primer Express® software 
calculates two Tms: one Tm for the sequence-specific primer and one Tm for the tailed primer. Tm 
data is displayed as a double number separated by a virgule (forward slash), for example: 60/76.

%GC The G+C content of a primer, expressed as a percentage of the whole. GC content affects the Tm 
of the primer.

ambiguous residue Any IUPAC designation other than A, C, G, or T. For more information, see 
Appendix F, �IUPAC Codes.�

amplicon The entire sequence amplified by the PCR process, including primer sequence(s).

discriminatory residue In Allele Specific PCR, a residue present in one or both primer pairs that 
selectively discriminates one set of sequences from the other.

excluded region A region that is not considered by the Primer Express software when calculating 
primers. Excluded regions may be contained in sequence files processed by outside agencies such 
as GenBank database or Factura� software. Excluded regions may also be entered in the Primer 
Express software on the Sequence page using the Exclude Region tool or the Find and Exclude 
menu option.

forward primer An oligonucleotide that primes in the forward direction, either for PCR or sequencing. A 
Nested PCR document calculates two forward primers in every primer set.

GC Clamp The number of G or C residues required at the 3' end of the primers. In the Primer Express 
software, the GC Clamp can be set to any value, including zero (default). In most cases, a GC 
Clamp greater than three will cause no primers to be calculated.

Mg++ concentration The concentration of magnesium ion used in a reaction buffer.

optimal Having length and Tm that are within some specified range.

ORF Open Reading Frame. A selected DNA region translated into its corresponding amino acid 
sequence using the three-letter amino acid abbreviations directly beneath the sequence data. ORF 
annotations may be contained in sequence files processed by outside agencies such as GenBank 
database or Sequence Navigator® software, or they may be entered in the Primer Express software 
on the Sequence page using the ORF tool.
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pipeting excess The quantity of extra mixture you want to create in order to have some to spare. Also 
known as slop factor. The number entered is a percentage of the reaction volume.

primer-dimer A primer artifact, usually undesirable, that results from a primer hybridizing (and 
extending) on another primer instead of the target template.

protocol Instructions for performing PCR, similar to a recipe, that specify precise quantities of 
components, order of actions, and durations of events.

residue A nitrogenous base with single-letter designation corresponding to the IUPAC code. Also 
referred to as a base or nucleotide (nt). For more information, see Appendix F, �IUPAC Codes.�

reverse primer An oligonucleotide that primes in the reverse direction, either for PCR or sequencing. A 
Nested PCR document calculates two reverse primers in every primer set.

secondary structure A structure within the primer binding site that leads to hairpin loops and other 
undesirable PCR effects.

Ta Annealing temperature of a DNA fragment (amplicon or primer). Also referred to as Tanneal. Ta of a 
primer is usually 2 to 5 °C lower than the Tm. Ta is dependent upon the length and %GC of the 
fragment.

target region A region that is specifically included by the Primer Express software when calculating 
primers. Target regions are entered in the Primer Express software on the sequence page using the 
Target tool. The Multiplex PCR document is the only document that allows more than one target 
region.

TaqMan® Probe A short oligonucleotide that has been labeled with a Reporter dye and a Quencher dye. 
The TaqMan probe is designed to hybridize to a specific sequence of interest located between the 
forward and reverse PCR primers. During PCR, the probe hybridizes (anneals) to the target 
template and is later cleaved by AmpliTaq® DNA polymerase. This cleavage separates the Reporter 
from the Quencher, resulting in an increase of Reporter dye fluorescence.

TaqMan® MGB Probe A short oligonucleotide with a reporter dye attached to the 5´ end and a 
non-fluorescent quencher attached to the 3´ end. The probe is coupled with a minor groove binder, 
which increases the melting temperature, Tm, of the probes. TaqMan MGB probes exhibit greater 
differences in Tm values between matched and mismatched probes, which provides more accurate 
allelic discrimination.

Tm The melting temperature of PCR or sequencing primers. Tm is the temperature at which 50% of the 
oligonucleotides are in double-stranded conformation and 50% are single stranded. Also, the 
temperature at which 50% of a long DNA fragment (for example, an amplicon) is in double-stranded 
conformation.
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File menu 7-2 to 7-7
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Export command 7-6
Import command 7-6
New command 7-2 to 7-3
Open command 7-3 to 7-4
Open Results command 7-4 to 7-5
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files
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imported file types C-2

alignment files C-2
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Find and Exclude command 7-11 to 7-12
Find Primers Now command 7-14 to 7-15
Find Sequence command 7-9 to 7-11
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Find Target command 7-11
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document 4-68
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Forward Primer End annotation 6-15
junction annotation 6-25
line annotation 6-23
probe annotation 6-9
Reverse Primer annotation 6-17
Reverse Primer End annotation 6-19
target annotation 6-7
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Ambig test A-2
Amplicon Length test A-4
Amplicon Tm test A-5
Avoid Excludes test A-5
Clamp test A-2
GC test A-2
Primer Site Unique test A-4
Repeat test A-3
Secondary Struc test A-3
Target test A-5
Tm

test A-3
Tm Match test A-5

Primers page 5-33 to 5-37

about 5-33
features 5-34
Primer Data window 5-35 to 5-36
saving list of primers 5-37
scroll bar 5-33
viewing parameters 5-36

printer, compatible models 2-2
printing settings 7-6
Probe tool, using 6-8 to 6-9
Protocol pop-up menu 5-46
protocol, definition Glossary-2

Q
Quit command 7-7

R
Reaction Conditions page 5-30 to 5-32

about 5-30
diagram D-2
features 5-31
setting reaction condition values 5-32

Recipe page
Cycle Sequencing document 5-47 to 5-48
Sequencing Primer page 5-49

references, bibliographical H-1 to H-2
removing

all annotations 6-5
junction annotation 6-25
sequence text using Select tool 6-5
site annotations 6-27

Repeat test A-3
requirements, hardware and software 2-2
residue

consecutive A-4
definition Glossary-2

resizing, documents 4-6
restriction enzyme site

creating site 6-26 to 6-27
locating site 7-9

results
listing in Results Archive window 7-4 to 7-5
optimal primer 5-36

Results Archive window
listing results 7-4 to 7-5

Results page 5-50 to 5-51
about 5-50



features 5-51
Nested PCR document 5-52 to 5-53

annotating the results 5-52
saving 5-52
viewing/modifying saved results 5-53

stock concentrations 5-48
Reverse Primer End tool, using 6-18 to 6-19
Reverse Primer tool, using 6-16 to 6-17
reverse primer, definition Glossary-2
RT PCR document 4-43 to 4-44
rTth. See PCR enzyme
Rxn Cond page

concentration 5-31
See Reaction Conditions page

S
salt concentration D-1

Primer Test document 4-68
setting the concentration 5-51

Save As command 7-5
Save List button 5-34
Save Results button 5-51
saving

list of primers 5-37
primer list data 5-34
Results page, contents of 5-52
using the Results page 5-50 to 5-51

scale, changing on Map page 5-43
scroll bar, Primers page 5-33
Secondary Structure Graphic

Primer Test document 4-68
Secondary Structure test A-3
secondary structure, definition Glossary-2
Select tool, using 6-4 to 6-5

modifying an annotation 6-4
removing sequence text 6-5

sequence
annotating 6-2
excluding a region 6-10 to 6-11
importing multiple sequences 5-11
specifying a sequence region 6-6 to 6-7
specifying region where probe anneals 6-8 

to 6-9
sequence files, imported types C-2
Sequence Navigator file format C-2
Sequence page

Allele Specific PCR document 5-8 to 5-10

sequence text 6-4 to 6-5
highlighting sections 6-22 to 6-23
modifying an annotation 6-4
removing sequence text 6-5

sequences 5-11 to 5-15
annotating a sequence 5-15
editing a sequence 5-13 to 5-15
entering a sequence 5-12
file formats 5-5
importing a sequence 5-11
locking/locking a sequence 5-13

Sequencing Primer document 4-60
parameters page 5-29
Recipe page 5-49

Sequencing Primer Recipe page
stock concentrations 5-49

Show Page Breaks command 7-12
Show/Hide Annotation Tools command 7-15
Show/Hide Interim Results command 7-15
Show/Hide Primer Data command 7-15
Show/Hide Primer Secondary Structure 

command 7-16
Show/Hide Status Bar command 7-16
site arrow cursor 6-26
Site tool, using 6-26 to 6-27
site, restriction enzyme, locating 7-9
slop factor. See pipeting excess
software

requirements 2-2
virus protection 2-3

sorting primer data 5-3
Standard Parameters page 5-19 to 5-23

about 5-19
features 5-20 to 5-21
more parameters 5-22

Standard Recipe page 5-45 to 5-46
Standard Sequence page 5-4 to 5-6
status bar, using 4-6
stock concentrations

number of tubes 5-46
pipeting excess 5-46
reaction volume 5-46, 5-48, 5-49
Results page 5-48
Sequencing Primer Recipe page 5-49
volume 5-46

Stoffel. See PCR enzyme
Index-7



T
Ta, definition Glossary-2
Taq Polymerase. See Standard Recipe page
TaqMan Assay Design Guidelines 4-7
TaqMan Conventional Probe

about 4-8
amplifying custom target sequences 4-9
amplifying target sequences 4-16
definition Glossary-2
generating a list of candidate primers and 

probes 4-11
Primer and Probe Design Guidelines 4-10
quantitation 4-9
selecting primers and probes 4-14
TaqMan Probe and Primer Design 

document 4-9
using for allelic discrimination 4-16

TaqMan MGB Probe
about 4-8
amplifying target sequences 4-27
definition Glossary-2
features 4-28
loading the sequence 4-31
selecting primers and probes 4-14
TaqMan Probe and Primer Design 

document 4-29
using for allelic discrimination 4-27

TaqMan Probe document
parameters page 5-28
using Probe tool 6-8 to 6-9

target region
definition Glossary-2
tool, adding target annotation 6-6 to 6-7

Target test A-5
technical support 1-3 to 1-10

e-mail address 1-3
Internet address 1-8
regional sales offices 1-6 to 1-8
telephone/fax (North America) 1-4, 1-6

Template DNA, setting the concentration 5-51
template, setting the reactions 5-30 to 5-32
tests, to eliminate primers A-2 to A-5

Ambig test A-2
Amplicon Length test A-4
Amplicon Tm test A-5
Avoid Excludes test A-5
Clamp test A-2

GC test A-2
Primer Site Unique test A-4
Repeat test A-3
Secondary Struc test A-3
Target test A-5
Tm Match test A-5
Tm test A-3

theory, of operations E-1 to E-7
how Primer Express finds primers E-2
stages for calculating primer pairs E-6
stages for calculating primers E-3 to E-5

three-step PCR 5-51
Tm

definition Glossary-2
Match test A-5
parameters 5-20
test A-3

tools, groupings of 6-3
training

obtaining information 1-10
transparent open hand cursor 6-4, 6-27
tubes for PCR 5-46
Turn AutoFind ON/OFF command 7-14
two-step PCR 5-51

V
virus protection 2-3

W
Windows menu 7-17
Index-8
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